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AnywhereUSB® Plus is a Remote USB 3.1 Hub that implements USB over IP® technology over Gigabit
Ethernet networks. The Hub enables communication with USB-enabled devices from virtualized
systems and from remote host computers. You can securely deploy AnywhereUSB® Plus Remote USB
3.1 Hubs in non-secure environments, making it ideal for point-of-sale, kiosks, surveillance, industrial
automation, or any mission-critical enterprise application. This Gigabit Ethernet-attached solution
provides 2, 8, or 24 USB 3.1 ports to connect a wide range of peripheral devices such as USB license
dongles, scanners, printers, cameras, storage media, or other USB devices. The 8- and 24-port models
provide support for 10 Gigabit Ethernet and include SFP+ interfaces.

User roles
The different user roles that work with the AnywhereUSB Plus Hub are described in the table below.

Role Description

Windows Administrator The Windows administrators have the Windows permissions to
install the AnyhwhereUSB Manager software on the computer.
The Administrator can start, stop, and configure the
AnywhereUSB Manager if it is run as a service.

Hub administrator The Hub administrators have access to the Hub password. This
enables the administrators to access and perform all activities
to configure andmaintain the Hub using the Configuration
and Management web UI and the Hub CLI commands.

User A user can log into their computer and access the
AnywhereUSB Manager that has been installed on the
computer by the Windows administrator and is not running as a
service.
Within the AnywhereUSB Manager, the user can connect to the
groups on the remote Hubs to which they have been given
access by a Hub administrator.
A user cannot access the the Configuration and Management
web UI or use the Hub or AnywhereUSB Manager CLI
commands.

AnywhereUSB® Plus User Guide for versions 3.x and below 8
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Terminology

Role Description

Computer The physical or virtual equipment (such as a PC, laptop, or virtual
machine), which is used to remotely access the AnywhereUSB Plus
Hub.

Client ID The client ID is a unique identifier assigned to a user account the first
time a user logs in to a computer and opens the
AnywhereUSB Manager.
During this process, the AnywhereUSB Manager creates a secure
identity certificate that is associated with the client ID. This certificate
is used to validate your user account with the Hub. For more
information, see Client ID.

Group A group is a set of USB ports on an AnywhereUSB Plus Hub with
exclusive access to a single user account. Each USB port can be
assigned to only one group by the Hub administrator.
When you log into the computer and connect to a Hub, you are allowed
to connect to any groups assigned to your client ID.
See Create groups and assign to client IDs for more information.

Supported OS
Microsoft Operating systems supported:

n Microsoft Windows 7

n Microsoft Windows 8.1

n Microsoft Windows 10

n Microsoft Windows Server 2012 R2

n Microsoft Windows Server 2016

n Microsoft Windows Server 2019



Get started

This section explains what comes with each AnywhereUSB® Plus model, how to install the necessary
software, and how to connect the hardware. After you have verified the AnywhereUSB® Plus Hub
components, the software installation, hardware connection, and initial connection process must be
done individually for each computer.

Note The steps in this process can only be done by an administrator. Once the setup is complete, any
user can connect to a group, as described in step 6 below, Connect to groups.

1. Verify product components.

2. Install the AnywhereUSB Manager.

3. Connect the hardware.

4. Verify initial connection.

5. Change the Hub password.

6. You should update the firmware on the Hub to ensure you have the latest version. See Update
the firmware.

7. After you have completed your initial connection, you can create groups and assign ports to
each group. Once this step is complete, you can specify the groups that a client ID is allowed to
access. See Create groups and assign to client IDs.

8. Connect to groups. Any user (Administrator or non-Administrator) can open the AnywhereUSB
Manager and connect to the Hubs and groups to which access is allowed.

Note If you installed the AnywhereUSB Manager as a service in step 2, above, only
Administrators can open the AnywhereUSB Manager.

9. The Hub administrator can use the Configuration and Management web user interface
(web UI) to configure networks parameters, services, and other Hub features. You can update
the firmware, back up the configuration, view system information and logs, and reboot the
Hub. See Administrators: Configure the AnywhereUSB® Plus in the web user interface.

Verify product components
All AnywhereUSB® Plus models include the AnywhereUSB® Plus device in the box. Additional
equipment may be required or may be optional.

AnywhereUSB® Plus User Guide for versions 3.x and below 10
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n AnywhereUSB 8 Plus components

n AnywhereUSB 24 Plus components
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AnywhereUSB 2 Plus components
Verify that you have the following included and required additional equipment.

Equipment Description

Included equipment AnywhereUSB 2-port device.

Required additional equipment n STP Cat 7 Ethernet cable

n Power supply kit (recommended): 1.8 amps per port. Digi
PN 76000965.

n Alternate power supply kits (may be used if USB port
charging is not required):

o AC Power Supply: US plug to 5 VDC. 2.5 mm locking
barrel plug (3 A max). Digi PN 76000934.

o AC Power Supply: EU plug to 5 VDC. 2.5mm locking
barrel plug (3 A max). Digi PN 76000935.

o AC Power Supply: Standard Temperature, Universal
plugs (US, EU, UK, AU) to 5 VDC. 2.5mm locking
barrel plug (3 A max). Digi PN 76002021.

Item Name Description

1 Ethernet connector Connect the STP Cat 7 Ethernet cable.
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Item Name Description

2 USB LEDs and ports The USB port supports 1.1, 2.0, and 3.1 USB devices.
The LED illuminates as follows, based on the speed of the USB
device:

n 1.1 (Full speed): Yellow

n 2.0 (High speed): Green

n 3.1 (Super speed): Blue

3 Reset button Use this button to reset the AnywhereUSB® Plus Hub configuration
to factory defaults. See Use the Reset button to restore factory
defaults.

4 (Power) LED The LED is solid blue when the device is powered on.
This LED is also used for the Find Me feature. When this feature is
activated, the LED blinks green and then orange. You can configure
the Find Me feature in the web UI or by using the findme CLI
command.

5 Power connector Connect the power supply: 5 Volt DC center positive.
The Hub draws 5 Ampmaximum when both USB ports are drawing
1.8 Amps each.



Get started Verify product components

AnywhereUSB® Plus User Guide for versions 3.x and below 14

AnywhereUSB 8 Plus components
Verify that you have the following included, required, and optional equipment.

Equipment Description

Included equipment n AnywhereUSB 8-port device

n Power supply

n Rack mounting brackets and screws

Required additional equipment n STP Cat 7 Ethernet cable

n IEC 60320 power cord

Optional equipment n SFP+ module

n RS232 DB9 Console cable
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Item Name Description

1 USB port
LEDs

The USB ports support 1.1, 2.0, and 3.1 USB devices.
The LED illuminates as follows, based on the speed of the USB device:

n 1.1 (Full speed): Yellow

n 2.0 (High speed): Green

n 3.1 (Super speed): Blue

2 ETH1 Connect a Cat 7 STP Ethernet cable.

Note Digi recommends that you use either the Ethernet cable or the
SFP+ module. If both the Ethernet cable and the SFP+ module are
connected, the SFP+ module will have priority.
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Item Name Description

3 SFP+ Connect an SFP transceiver module for fiber connection, such as Finisar
Network FTLX8574D3BCL SFP+.

4 DB9
console

Used to access a console using the RS232 DTE interface.

5 Fan The LED shows the status of the fan:
n Solid green when the fan is running within normal range of use.

n Solid red if the fan slows down or the Hub is overheating.

5 Wi-Fi
Service

Reserved for future use.

5 User LED used for the Find Me feature. When this feature is activated, the
LED blinks orange and then green. You can configure the Find Me
feature in the web UI or by using the findme CLI command.

5 Power The LED is solid blue when the Hub is powered.

5 WWAN1
Signal

Reserved for future use.

5 WWAN1
Service

Reserved for future use.

6 BT Reserved for future use.

7 Wi-Fi1 Reserved for future use.

8 Wi-Fi2 Reserved for future use.

9 Wi-Fi3 Reserved for future use.

10 Wi-Fi4 Reserved for future use.

11 WWAN2 Reserved for future use.

12 WWAN1 Reserved for future use.

13 Reset
button

Use this button to reset the AnywhereUSB® Plus Hub configuration to
factory defaults. See Use the Reset button to restore factory defaults.

14 Power
connector

Connect the power supply.
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AnywhereUSB 24 Plus components
Verify that you have the following included, required, and optional equipment.

Equipment Description

Included equipment AnywhereUSB 24-port device

Required additional equipment n STP Cat 7 Ethernet cable

n IEC 60320 power cord

Optional equipment n An additional STP Cat 7 Ethernet cable

n An additional IEC 60320 power cord

n SFP+ modules

n RS232 DB9 Console cable



Get started Verify product components

AnywhereUSB® Plus User Guide for versions 3.x and below 18

Item Name Description

1 DB9 Console Used to access a console using the RS232 DTE interface.

2 USB port LEDs The USB ports support 1.1, 2.0, and 3.1 USB devices.
The LED illuminates as follows, based on the speed of the USB
device:

n 1.1 (Full speed): Yellow

n 2.0 (High speed): Green

n 3.1 (Super speed): Blue

3 ETH 1/2 Connect a Cat 7 STP Ethernet cable. The second Ethernet cable is
optional and used for redundancy.

Note Digi recommends that you use either the Ethernet cable or
the SFP+ module. If both the Ethernet cable and the SFP+ module
are connected, the SFP+ module will have priority.

4 SFP+ 1/2 Connect an SFP transceiver module for fiber connection, such as
Finisar Network FTLX8574D3BCL SFP+. The second SFP+ module is
optional and used for redundancy.

5 Fan1 The LED shows the status of Fan 1:
n Solid green when the fan is running within normal range of

use.

n Solid red if the fan slows down or the Hub is overheating.

5 Fan2 The LED shows the status of Fan 2:
n Solid green when the fan is running within normal range of

use.

n Solid red if the fan slows down or the Hub is overheating.

5 User LED used for the Find Me feature. When this feature is activated,
the LED blinks orange and then green. You can configure the Find
Me feature in the web UI or by using the findme CL command.

5 PSU1 The LED is blue when the Hub is powered, and solid red if the Hub
is not powered or the supply has failed.

5 PSU2 The LED is blue when the Hub is powered, and solid red if the Hub
is not powered or the supply has failed.

5 Wi-Fi Service Reserved for future use.

5 WWAN1 Service Reserved for future use.

5 WWAN1 Signal Reserved for future use.

6 BT Reserved for future use.
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Item Name Description

7 Wi-Fi1 Reserved for future use.

8 Wi-Fi2 Reserved for future use.

9 Wi-Fi3 Reserved for future use.

10 Wi-Fi4 Reserved for future use.

11 WWAN2 Reserved for future use.

12 Core module Reserved for future use.

13 WWAN1 Reserved for future use.

14 Fan 1 Primary fan.

15 Fan 2 Secondary fan.

16 Power connector Connect the power supply.

17 Power connector Connect the second (optional) power supply. This is used for
redundancy.

Reset button The reset button is on the side of the Hub.
Press this button to reset the AnywhereUSB® Plus Hub
configuration to factory defaults. See Use the Reset button to
restore factory defaults.

Install the AnywhereUSB Manager
The Anywhere USB Manager software must be downloaded from the Digi support site and installed
on your computer. After the manager software installs, the AnywhereUSB Manager launches. The
AnywhereUSB Manager automatically discovers AnywhereUSB® Plus Hubs on the local subnet.
The Windows administrator must perform the software install.

Prerequisites
Before you begin, you should decide whether you want to run the AnywhereUSB Manager as a stand-
alone or as a service. For detailed information, see Install AnywhereUSB Manager as a service or
stand-alone.

1. Navigate to https://www.digi.com/support#support-tools.

2. From the Support Downloads section, click Drivers.

3. Find and select AnywhereUSB Plus from the product list.

4. Select your AnywhereUSB Plus model.

5. Select and download the appropriate software for your operating system.

Note You can save the downloaded software to your computer before you start the install
process. This is useful if you decide to uninstall the AnywhereUSB Manager in the future.

6. Click on the downloaded software to launch the AnywhereUSB Manager installation wizard.
The Welcome screen appears.

http://www.digi.com/support/product-support
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7.  Click Next. The Ready to Install screen appears.

8.  Click Install. A status bar shows the progress of the installation process. When complete, the
Completed screen appears.

9. Select from the options on the screen:
n Launch AnywhereUSB Manager: Launches the AnywhereUSB Manager when the

installation completes. This is selected by default.

n Run AnywhereUSB Manager at Startup: Automatically launch
AnywhereUSB Manager each time you log in to your Windows user account. This is
selected by default, and Digi recommends that you do not de-select this option.

n Run AnywhereUSB Plus as a Windows Service: Only a Windows administrator is able
to open and use the AnywhereUSB Manager. If you are not the Windows administrator,
you are cannot open the AnywhereUSB Manager but you have access to the devices
connected to the Hub that are in the groups to which your client ID is assigned. See
Install AnywhereUSB Manager as a service or stand-alone.

Note If you select the Run AnywhereUSB Plus as a Windows Service option, and a non-Windows
administrator logs into the computer, the AnywhereUSB Manager will not display, even if the Launch
AnywhereUSB Manager and/or the Run AnywhereUSB Manager at Startup options are selected.
When running the AnywhereUSB Manager as a service, you must be logged in to the computer as a
Windows administrator to be able to open and use the AnywhereUSB Manager.
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10. Click Finish. The client ID confirmation dialog appears.

11. Enter a unique client ID. See Client ID for more information about how the client ID is used by
your computer and the Hub to create a connection.

12. Click OK. The AnywhereUSB Manager launches.

Install AnywhereUSB Manager as a service or stand-alone
You can choose to install the AnywhereUSB Manager as a stand-alone application or as a service.
Review the sections below for more detailed information.

Note A Windows Administrator must perform the AnywhereUSB Manager software install.

Stand-alone
Install the AnywhereUSB Manager as a stand-alone if you want to manage USB connections and only
be connected to them when you are logged in.
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If you install the AnywhereUSB Manager as a stand-alone, Digi recommends that you select the Run
AnywhereUSB Manager at Startup option during the installation process to automatically launch the
AnywhereUSB Manager each time you log in to your Windows user account.
If the auto connect feature is enabled, the AnywhereUSB Manager automatically connects to groups
and devices when the user logs in and starts the AnywhereUSB Manager.
Both Administrators and non-Administrators can run the AnywhereUSB Manager and configure it.
Groups and devices are disconnected when user logs out.

Service
Install the AnywhereUSB Manager as a service if USB devices must be available before user login and
remain connected even when all users log out. The service automatically runs in the background.
Only an Administrator can start the AnywhereUSB Manager or command line to configure service.
If the auto connect feature is enabled, the AnywhereUSB Manager automatically connects to groups
and devices at Windows boot time.
Groups and devices remain connected when the user logs out.
If you are not the Administrator, you are able to see and use the devices connected to the Hub that
are in the groups to which your client ID is assigned, but you cannot choose to connect to an additional
Hub or device without assistance from an Administrator.

Connect the hardware
Before you begin, verify that you have your AnywhereUSB® Plus Hub, the required additional
equipment for your Hub, and any additional optional equipment. See Verify product components.

WARNING! Digi recommends that you use a private network to connect the computer to
the Hub, as described in this section. If you do not use a private network, and the same
client ID is assigned to both a known and an unknown computer, there is a risk of
misidentification. In this situation, an unknown computer may connect to the Hub before
the known computer does, resulting in the wrong computer being allowed to connect to
your Hub.

It is recommended that you download a PDF copy of this manual to your computer.
1. Connect one end of a Shielded CAT 7 (STP) Ethernet cable to the Hub.

2. Connect the other end of the Ethernet cable to your computer.

3. Connect the appropriate power supply for your model:
n AnywhereUSB 2 Plus Hub: Connect the power supply to the Hub, and use the twist-

lock feature to secure the power supply.

n AnywhereUSB 8 Plus Hub: Connect the power supply to the Hub and tighten the
screws to secure.

n AnywhereUSB 24 Plus Hub: Connect one IEC 60320 power cord into the Hub. The
second power cord is used for redundancy.

4. Plug the power supply to an outlet. You may have two power supplies for an AnywhereUSB 24
Plus Hub.

5. Verify that the blue power LED is illuminated.

https://www.digi.com/resources/documentation/digidocs/pdfs/90002294.pdf
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Verify initial connection
After the hardware has been connected and powered on, and you have installed the AnywhereUSB
Manager, verify that the Hub connection is working as expected. You will need a USB flash drive to
follow the verification process below.

1. Verify that your Hub powered on. The power LED is solid blue.

2. Plug your USB flash drive into port 1 on the Hub.

3. Verify that the USB port 1 LED is solid yellow, green, or blue, depending on whether the USB
flash drive is 1.1, 2.0, or 3.1.

4. If not already open, launch the AnywhereUSB Manager.

5. Expand AnywhereUSB® Plus Hubs to display a list of AnywhereUSB® Plus Hubs.

6. Verify that the serial number of the Hub is in the list. You can find the serial number on the
Hub's label.

7. You will notice that the Manager is showing the Hub in an error state, with a red X appearing
next to the Hub name. Click on the Hub to update information in the Hub Status pane. The
Hub State appears as "Unregistered Client ID."

This is a security feature. The Hub administrator needs to allow each new client ID by adding
the client ID to the client list.
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8. Before you can register the client ID with the Hub, you must add the client ID to the Hub from
the web UI.

a. Right-click on the Hub and select Open Web UI.

b. A login dialog displays. Enter the following:
n User name: admin

n Password: Located on the label on the bottom of the Hub. Note that the
password is case-sensitive andmust be typed in exactly as it appears on the
label.

Note The first time you launch the web UI, a warning dialog may appear if your
internet connection is not private. In this situation, continue to access the device.
The log in dialog appears.

c. Click Login. The web UI appears.

d. Click AnywhereUSB from the Configuration section. The AnywhereUSB
Configuration page appears.

e. In the Client Settings section, click Add Client. A new row labeled "New Client" is
added to the client list and the Settings for Client section is populated for the new
client.

f. In the Client ID field, enter the client ID you assigned to your computer when you
installed the AnywhereUSB Manager.

g. In the Description field, enter a descriptive name for the computer. This step is
optional.

h. Click the check box next to group 1.

i. Click Apply to save the Hub settings.

9. Open the AnywhereUSB Manager. The Manager connects to the Hub.

10. Expand the Hub to display the groups.

11. Expand Group 1 to display the USB flash drive connected to Group 1.
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12. Right-click on Group 1 and select Connect to Group. The USB flash drive is available in
Windows.



Create groups and assign to client IDs

For each Hub, the Hub administrator can assign a number of USB ports to a group. The Hub
administrator can also assign groups to client IDs. Groups are created and assigned to client IDs in the
AnywhereUSB page in the web UI.
When the client ID connects to a Hub, the computer is allowed to access the ports in the groups
assigned to the client ID. The same groups can be assigned to more than one client ID on a Hub. Note
that connecting to a group is exclusive and only one client can connect to a group at a time.

1. Add client IDs to the client list.

2. Create groups and assign ports to the group.

3. Assign a group to a client ID.

Create groups and assign ports to the group
In the AnywhereUSB page in the web UI, you can assign a name to each group, and specify the ports
in each group. Each port can only be assigned to one group. Any unassigned ports are included in the
Unassigned row that displays beneath the list of groups.
If a group has ports assigned to it, the group will display in the AnywhereUSB Manager, even if a USB
device is not connected to a port. You can reassign the unused ports in a group so the group does not
appear in the AnywhereUSB Manager. See Hide a group in the AnywhereUSB Manager.

1. Open the web UI for your selected Hub.

2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.

3. In the Group Description field, enter a name for a group. This name displays in the Group
Name field in the Group Status pane in the Anywhere USB Manager.

4. In the row for the group, select the ports for that group. Each port on a Hub can be assigned to
only one group. Ports that are not assigned to a group can be put in the default Unassigned
group.

5. Repeat the steps 3 and 4 for each group you want to create.

6. When done, click Apply to save the changes.

AnywhereUSB® Plus User Guide for versions 3.x and below 26
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Assign a group to a client ID
You can assign the groups to a client ID. When the client ID connects to the Hub, the computer can
access all of the ports in the specified groups.

1. Open the web UI.

2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.

3. In the client list in the Client Settings section, select the client ID to which you want to assign
groups. Information about the selected client ID displays in the Settings for Client section.

4. Click the check box next to a group to which the computer is allowed access. As you select
groups, the selected group numbers appear in the Group Access field in the Settings for
Client section.
You can also manually enter group numbers in the Group Access field.

5. Click Apply to save the changes.
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Connect to a group or USB device in the
AnywhereUSB Manager

When you connect to a group, you are given exclusive access to all of the ports in the group to which
you are allowed access. All other users are blocked from access to the ports in that group until you
disconnect from the group. A user can connect to more than one group at a time.

Note If you have enabled auto connect for a group, you are automatically connected to those groups
when you log in to your computer and AnywhereUSB Manager opens automatically, or when you
manually open and log into AnyhwereUSB Manager. See Configure auto connect.

When a USB device is plugged in to a port on a Hub, the device displays in the list of devices in the
group. Note that a groupmay have ports that do not have a connected device. Only ports with a
connected USB device display in the AnywhereUSB Manager.

Connect to a group or a USB device in the AnywhereUSB Manager
You can connect to all of the USB devices and ports in a group, or to one device in a group.

n Connect to a group: To connect to a group, right-click on the group name and click Connect to
Group.

n Connect to a USB ports in a group: You can connect to the USB ports in a group depending
on whether you are allowed access to the port and if you are connected to the group:
l If you are connected to the group, right-click on a USB device name and click Connect to

Device. You are connected to that USB device and to all of the USB ports in the group.

l If you are not connected to the group, right-click on the USB device name and click Connect
to Group to connect to the group and the USB device.

l If the group is owned by another user, you are not allowed to connect to the device.

Connect to a group
You can connect to a group so that you have access to the ports in the group. Once you have
connected to a group, no one else can connect to that group. You cannot connect to a group that is
already is use.
When you have connected to a group, a note appears next to the group name, next to the devices in
the group, and in the Group Status pane to show that the device is being used by you.

1. Open the Anywhere USB Manager.

2. Expand AnywhereUSB® Plus Hubs to display the Hubs.
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3. Expand a Hub to display the groups in the Hub.

4. Right-click on the group to which you want to connect.

5. Select Connect to Group. A note appears next to the group name, next to the devices in the
group, and in the Group Status pane to show that the device is being used by you.

Connect to a USB device
You can connect to a USB device in a group to which you have access. You cannot connect to a device
in a group that is already is use by another user.
When you have connected to a device, a note appears next to the device name and in the Device
Status pane to show that the device is being used by you.

1. Open the Anywhere USB Manager.

2. Expand AnywhereUSB® Plus Hubs to display the Hubs.

3. Expand a Hub to display the groups in the Hub.

4. Expand a group to display the USB devices in the group.

5. Right-click on the device to which you want to connect.

6. The connect menu option available depends on whether you are already connected to the
group.

n Connected to the group: Right-click on the USB device name and click Connect to
Device to connect to the USB device.

n Not connected to the group: Right-click on the USB device name and click Connect to
Group to connect to the group and the USB device.

A note appears next to the device name and in the Device Status pane to show that the device
is being used by you.
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Manage the Hubs using the AnywhereUSB Manager

You can use the AnywhereUSB Manager to view the AnywhereUSB Plus Hubs that are allowed to
connect to your computer. You can also connect to groups of USB ports on the Hubs.
By default, the AnywhereUSB Manager is configured to automatically discover Hubs that are
connected to the same network as your computer. You can allow a connection to additional Hubs that
are not on the same network.

Note Before you begin, make sure you have installed the AnywhereUSB Manager.

Start the AnywhereUSB Manager 33
Rename AnywhereUSB® Plus Hubs, groups, and USB devices 33
Disconnect from a group or USB device 34
Configure auto connect 35
Manage the list of known Hubs 36
Hide an individual Hub 38
Hide all unauthorized Hubs 39
Minimize the AnywhereUSB Manager when launched 40
Autofind Hubs when the AnywhereUSB Manager launches 40
Specify search, response, and keepalive intervals for a Hub 41
Manage Hub credentials 42
View latency graph 44
View the AnywhereUSB Manager system messages 44
View AnywhereUSB® Plus license information 44
Restore AnywhereUSB Manager default configuration 45
Access the online help from the AnywhereUSB Manager 46
AnywhereUSB Manager window 46
Exit the AnywhereUSB Manager 53
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Note The AnywhereUSB Manager supports the AnywhereUSB Plus family of products: AnywhereUSB
2 Plus, AnywhereUSB 8 Plus, AnywhereUSB 24 Plus. The earlier AnywhereUSB products
(AnywhereUSB 2, AnywhereUSB 5, and AnywhereUSB 14) use a different driver package. For more
information, please refer to the AnywhereUSB product page.

Start the AnywhereUSB Manager
You can search for and launch the Anywhere USB Manager using the Windows application search
feature or from the Digi International Start menu.
If you selected the Run AnywhereUSB Manager at Startup option during the installation process,
the tool launches automatically each time you log into your computer. See Install the AnywhereUSB
Manager.
To manually start the Anywhere USB Manager:

1. Log in to your computer.

2. Double-click the Anywhere USB Manager shortcut on your desktop.

Rename AnywhereUSB® Plus Hubs, groups, and USB devices
Each AnywhereUSB® Plus Hub and group has a default name that displays in the AnywhereUSB
Manager. You can also assign a local name to each Hub, group, or USB device that displays in the
AnywhereUSB Manager, which can help you to uniquely identify your local Hubs, groups, and USB
devices.
The local name is local to the computer on which the AnywhereUSB Manager is running. No other
user can see the local name.

n Assign a local name to a Hub

n Assign a local name to a group

n Assign a local name to a USB device

Assign a local name to a Hub
You can give a AnywhereUSB® Plus Hub a local name. The name displays in the Hub Status pane in the
AnywhereUSB Manager and also in the tree view. The local name is local to the computer on which
the AnywhereUSB Manager is running.

Note The Hub local name is different from the default Hub name. For detailed information about the
default name, see Rename a Hub and the groups in a Hub.

1. Open the AnywhereUSB Manager.

2. Expand AnywhereUSB® Plus Hubs to display the Hubs.

3. Right-click on the Hub that you want to give a local name.

https://www.digi.com/support/identifyfamily?family=45


Manage the Hubs using the AnywhereUSB Manager Disconnect from a group or USB device

AnywhereUSB® Plus User Guide for versions 3.x and below 34

4. Select the Assign Local Name menu option. A dialog appears.

5. In the field, enter a local name for the Hub.

6. Click OK.

Assign a local name to a group
You can give a group a descriptive local name. The local name displays in the Group Status pane in the
AnywhereUSB Manager and also in the tree view. The local name can be seen only on the computer
on which the AnywhereUSB Manager is running.

Note The group local name is different from the default group name. For detailed information about
the default name, see Rename a Hub and the groups in a Hub.

1. Open the AnywhereUSB Manager.

2. Expand AnywhereUSB® Plus Hubs to display the Hubs.

3. Expand the Hub that has the group you want to give a local name.

4. Right-click on the group that you want to rename.

5. Select the Assign Local Name menu option. A dialog appears.

6. Enter a local name for the group.

7. Click OK.

Assign a local name to a USB device
You can assign a local name to a USB device that displays in the in the Device Status pane and also in
the tree view. The local name is local to the computer on which the AnywhereUSB Manager is
running.

1. Open the AnywhereUSB Manager.

2. Expand AnywhereUSB® Plus Hubs to display the Hubs.

3. Expand the Hub that has the group to which the to USB device is attached.

4. Expand the appropriate group to display the USB devices in the group.

5. Right-click on the USB device that you want to give a local name.

6. Select the Assign Local Name menu option. A dialog appears.

7. In the field, enter a local name for the USB device.

8. Click OK.

Disconnect from a group or USB device
You can disconnect from any group or USB device in the group to which you no longer need access.

n Disconnect from a group

n Disconnect from a USB device
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Disconnect from a group
You can disconnect from a group that has ports you no longer need access to. You are disconnected
from all USB devices and ports in that group. Any other user can then connect to that group.

Note If you have auto connect enabled for the group, you are not allowed to disconnect from the
group. You have to first disable auto connect, and then disconnect from the group. The next time you
log in to your computer, you will not be automatically connected to this group.

1. Open AnywhereUSB Manager.

2. Expand AnywhereUSB® Plus Hubs to display the Hubs.

3. Expand a Hub to display the groups in the Hub.

4. Right-click on the AnywhereUSB® Plus group from which you want to disconnect.

5. Select Disconnect from Group. A note appears in the Group Status pane to show that the
group is not being used.

Disconnect from a USB device
You can disconnect from a USB device to which you no longer need access. You can disconnect from a
USB device that is in a group to which you are connected. Other users cannot connect the USB device,
since you still own the group that the USB device is in.

Note If you have auto connect enabled for the group, you can disconnect from a USB device in the
group, but note that the device will be connected again the next time you log in to your account.

1. Open AnywhereUSB Manager.

2. Expand AnywhereUSB® Plus Hubs to display the Hubs.

3. Expand a Hub to display the groups in the Hub.

4. Expand a group to display the USB devices in the group.

5. Right-click on the USB device from which you want to disconnect.

6. Select Disconnect from Device. A note appears in the Device Status pane to show that the
device is not being used.

Configure auto connect
You can enable the auto connect feature for a group (or multiple groups). This feature ensures that
whenever you open the AnywhereUSB Manager, you are automatically connected to all of the groups
to which you are allowed access that have auto connect enabled.
If you have auto connect enabled for the group, auto connect controls how you can disconnect from a
group:

n You are not allowed to disconnect from the group. You have to first disable auto connect, and
then disconnect from the group. The next time you start your computer, you will not be
automatically connected to this group.

n You can disconnect from a USB device in the group, but note that the device will be connected
again the next time you start your computer.
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For this to work as expected, you should also choose to automatically start the AnywhereUSB
Manager each time you start your computer.
For example, you can enable auto connect for a group that has a camera connected to a port in the
group. Every time the computer starts, the AnywhereUSB Manager starts and automatically
connects the camera to your computer.

Enable auto connect for a group
You can choose to automatically connect to a selected group each time you open the AnywhereUSB
Manager.

Note You can disable auto connect at any time.

1. Open AnywhereUSB Manager.

2. Expand AnywhereUSB® Plus Hubs to display the Hubs.

3. Expand a Hub to display the groups in the Hub.

4. Right-click on the AnywhereUSB® Plus group to which you want to automatically connect.

5. Select Enable Auto Connect. If you were not already connected to the group, you are
immediately connected to the group. A note appears next to the group name and in the Group
Status pane to show that you are connected to the group.

Disable auto connect for a group
After you have enabled auto connect for a group, you can disable this option. You will no longer
automatically connect to this group when you open the AnywhereUSB Manager.

1. Open the AnywhereUSB Manager.

2. Expand AnywhereUSB® Plus Hubs to display the Hubs.

3. Expand a Hub to display the groups in the Hub.

4. Right-click on the AnywhereUSB® Plus group to which you no longer want to automatically
connect at start up.

5. Select Disable Auto Connect to turn off the auto connect feature for the group.

Manage the list of known Hubs
You can create a list of Hubs to which your AnywhereUSB Manager is allowed to connect when you
open it. The Hubs you add to the list can be on the same network as your computer, or on a different
network.
Hubs that you have added to the known Hubs list display when you open the AnywhereUSB Manager.
These Hubs are in addition to any Hubs that are automatically discovered if you have enabled the
Autofind Hubs feature.

Add a Hub to the known Hub list
You can manually add Hubs to the known Hub list. The Hubs can be on the same network as your
computer, or on a different network.
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1. Open the AnywhereUSB Manager.

2. Select Configure > Known Hubs. The Known Hubs dialog appears.

3. Click Add. The Add Known Hub dialog appears.

4.  In the Hub Address field, enter the Hub IP address.

5.  If you want to update the TCP port number, click Advanced. The Hub TCP port (most
systems should leave at default) field displays.

a. In the Hub TCP port (most systems should leave at default) field, a TCP port
number is entered by default. You can change this entry, but it is not recommended.

b. Click Standard to hide the Hub TCP port (most systems should leave at
default) field.

6. Click OK. The Hub appears in the Hub list in the Known Hubs dialog.

7. Click Close to close the Known Hubs dialog. The AnywhereUSB Manager attempts to connect
to the new Hub.

Remove a Hub from the known Hub list
You can remove a known Hub that was added to the known Hubs list.

1. Open the AnywhereUSB Manager.

2. Select Configure > Known Hubs. The Known Hubs dialog appears.

3. From the list of known Hubs, select the Hub you want to remove.

4. Click Remove.

5. Click Close to close the Known Hubs dialog.

Working with the known Hubs list and the Autofind Hubs option
You should be aware of how the Autofind Hubs option works with the Hubs you add to the known
Hubs list.
If you have the Autofind Hubs option selected for the Hub, when you open the
AnywhereUSB Manager, all Hubs connected to the same network as your computer are
automatically found and appear in the AnywhereUSB Manager. In addition, any Hubs you have added
to the known Hubs list are found and also appear.

Duplicate connection
If you have added a Hub to the known Hub list that is on same network as your computer, and you
have the Autofind Hubs feature enabled, the Hub is found twice and appears twice in the
AnywhereUSB Manager. When you select the duplicate Hub in the AnywhereUSB Manager, the state
for that Hub is noted as "Duplicate connection" in the Status field.
In this situation, the Hub added to the known Hubs list is considered a duplicate Hub, and should be
removed from the known Hubs list.
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Considerations for removing a Hub on the same network as your computer
If you have the Autofind Hubs feature enabled and then remove a Hub from known Hubs list that
was on the same network as your computer, the Hub will still be automatically found and connected
to your computer when you open the AnywhereUSB Manager.
If you do not want the computer to be able to connect this Hub, you must de-select the Autofind
Hubs option. Note, however, that if this option is de-selected, Hubs on the same network as your
computer will not be automatically found. Only the Hubs in the list of known Hubs will be available
when you open the AnywhereUSB Manager.

Note As an alternative, you can choose to hide a Hub that is automatically found. This ensures that
while the Hub is still automatically found, it does not appear in the AnywhereUSB Manager.

Hide an individual Hub
You can choose to hide an individual Hub so that it does not appear in the AnywhereUSB Manager.
For example, you can hide an unauthorized Hub, or a Hub which users shouldn't access.

n You can choose to hide Hubs that currently display in the AnywhereUSB Manager, such as an
unauthorized Hub (which displays with a red X next to the Hub name), or a Hub which users
shouldn't access. See Hide a Hub that displays in the AnywhereUSB Manager.

n You can also choose to hide Hubs that don't currently display in the AnywhereUSB Manager,
but the client ID may have access in the future, such as a Hub on another network. See Hide a
Hub that does not currently display in the AnywhereUSB Manager.

Note You can choose to automatically hide all unauthorized Hubs, which is a Hub that has failed to
connect to your computer. See Hide all unauthorized Hubs.

Hide a Hub that displays in the AnywhereUSB Manager

Note After you have hidden a Hub, you can choose to re-display it. See Display a hidden Hub.
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1. Open AnywhereUSB Manager.

2. Right-click on the Hub that you want to hide. The shortcut menu appears.

3. Click Hide Hub. The next time the AnywhereUSB Manager updates, the hidden Hub is
removed from the Hub list and no longer displays.

Hide a Hub that does not currently display in the AnywhereUSB
Manager

Note After you have hidden a Hub, you can choose to re-display it. See Display a hidden Hub.

1. Open the AnywhereUSB Manager.

2. Select Configure > Hidden Hubs. The Hidden Hubs dialog appears.

3. Click Add. The Add Hidden Hub dialog appears.

4.  In the Hub Address field, enter the Hub IP address.

5. If you want to update the TCP port number, click Advanced. The Hub TCP port (most
systems should leave at default) field displays.

a. In the Hub TCP port (most systems should leave at default) field, a TCP port
number is entered by default. You can change this entry, but it is not recommended.

b. Click Standard to hide the Hub TCP port (most systems should leave at
default) field.

6. Click OK. The Hub appears in the Hub list in the Hidden Hubs dialog.

7. Click Close to close the Hidden Hubs dialog.

Display a hidden Hub
You can display any Hub that was hidden using the Hide Hub menu option.

1. Open AnywhereUSB Manager.

2. Choose Configure > Hidden Hubs. The Hidden Hubs dialog appears.

3. Click on the Hub that you no longer want to hide. To select more than one Hub, press CTRL as
you select Hub.

4. Click Remove. The selected Hubs are removed from the list.

5. Click Close. The next time the AnywhereUSB Manager updates, the hidden Hubs appear in the
list of Hubs.

Hide all unauthorized Hubs
You can choose to automatically hide all unauthorized Hubs, so they do not display in the
AnywhereUSB Manager. An unauthorized Hub is a Hub that has failed to connect to your computer. A
red X appears next to the Hub name.

n Automatically hide unauthorized Hubs

n Display unauthorized Hubs
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Note You can choose to automatically hide any indivudual Hub. See Hide an individual Hub.

Automatically hide unauthorized Hubs
You can choose to automatically hide all unauthorized Hubs, which is a Hub that has failed to connect
to your computer. An unauthorized Hub appears with a red X next to it in the list of Hubs in the
AnywhereUSB Manager.

Note After you have hidden unauthorized Hubs, you can choose to re-display unauthorized, hidden
Hubs. See Display unauthorized Hubs.

1. Open AnywhereUSB Manager.

2. Choose File > Preferences. The Preferences dialog appears.

3. Select the Hide unauthorized Hubs option.

4. Click Save. Hubs that have failed to connect no longer display in the AnywhereUSB Manager.

Display unauthorized Hubs
You can display the unauthorized Hubs that were hidden using the Hide unauthorized Hubs option.

1. Open AnywhereUSB Manager.

2. Choose File > Preferences. The Preferences dialog appears.

3. De-select the Hide unauthorized Hubs option.

4. Click Save. Hubs that have failed to connect now display in the AnywhereUSB Manager.

Minimize the AnywhereUSB Manager when launched
You can choose to automatically minimize the AnywhereUSB Manager when it launches.

1. Open AnywhereUSB Manager.

2. Choose File > Preferences. The Preferences dialog appears.

3. Click the Setup tab.

4. Determine whether you want to automatically minimize the AnywhereUSB Manager when it
launches.

n Select Start Manager minimized to automatically minimize the
AnywhereUSB Manager when it launches.

n De-select Start Manager minimized to open the AnywhereUSB Manager when it
launches.

5. Click Save.

Autofind Hubs when the AnywhereUSB Manager launches
You can choose to automatically find Hubs connected to the network when AnywhereUSB Manager
launches and repeatedly while the AnywhereUSB Manager is running, based on the interval specified
in the Preferences dialog.



Manage the Hubs using the AnywhereUSB Manager Specify search, response, and keepalive intervals for a Hub

AnywhereUSB® Plus User Guide for versions 3.x and below 41

1. Open AnywhereUSB Manager.

2. Choose File > Preferences. The Preferences dialog appears.

3. Click the Setup tab.

4. Determine whether you want to automatically find Hubs on the network when
AnywhereUSB Manager launches.

n Select Autofind Hubs to automatically find Hubs on the network. This is the default.

n De-select Autofind Hubs to ensure that the Hubs are not automatically found. In this
case, you must manually add the Hubs to which you want to connect.

5. Click Save.

Specify search, response, and keepalive intervals for a Hub
You can specify the search and response time for Hubs on the network, and the keepalive intervals for
the connection between the Hub and the AnywhereUSB Manager.

1. Open AnywhereUSB Manager.

2. Choose File > Preferences. The Preferences dialog appears.

3. Click the Advanced tab.
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4. Enter the following:
n Search for Hubs every .... sec: Specifies how often the AnywhereUSB Manager

searches the local network to discover AnywhereUSB® Plus Hubs and refresh the
AnywhereUSB Manager display.

Note You cannot manually perform a refresh of the Hubs displayed in the
AnywhereUSB Manager.

n Wait for Hub response for .... sec: Specifies the time interval from the last discovery
refresh that the AnywhereUSB Manager will stop looking for more Hubs.

n Send Keep-Alive every ... sec: Specifies how often the AnywhereUSB Manager sends
a keepalive request to the Hubs connected to the network. This impacts network
utilization because each AnywhereUSB Manager will send one packet at this interval to
each Hub to which it is connected.

n Keep-Alive Timeout ... sec: Specifies how long the AnywhereUSB Manager should
wait for a keepalive response. When the value of the response time is reached, the
Manager decides that a Hub is no longer available, and the computer is disconnected
from all groups and devices on that Hub.
l The keepalive timeout value would need to be longer if the network has more

latency (such as a cellular or satellite link), or an internet link with unreliable packet
delivery.

l If the value is too short, devices will be disconnected, which may have an adverse
affect on some devices, such as USB memory.

l If the value is too long, Hubs that are removed from the network will not be noticed
as gone for a long time, and devices that are no longer connected will be
unresponsive for a long time.

5. Click Save.

Manage Hub credentials
You can manually add, update, or remove the certificate associated with Hub on the
AnywhereUSB Manager. The Hub and the AnywhereUSB Manager must have matching certificates
to be able to communicate.
This feature works with the Auto-register Hub Cert option in the Preferences dialog. You should
determine whether you want to automatically register a Hub's certificate with the
AnywhereUSB Manager.

Enable and disable the auto-register Hub certificate
You can choose to automatically find Hubs connected to the network when AnywhereUSB Manager
launches.

1. Open AnywhereUSB Manager.

2. Choose File > Preferences. The Preferences dialog appears.
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3. Click the Setup tab.

4. Determine whether you want to automatically register a Hub with the
AnywhereUSB Manager.

n Select Auto-register Hub Cert to automatically register a Hub certificate with the
AnywhereUSB Manager. This is the default.

n De-select Auto-register Hub Cert to ensure that the Hub certificates are not
automatically registered. In this case, you must manually register a certificate for each
Hub.

5. Click Save.

Update a Hub certificate
You can choose to manually update a Hub's certificate and register a new certificate with the
AnywhereUSB Manager. This ensures that the Hub and the AnywhereUSB Manager can
communicate.

1. Open AnywhereUSB Manager.

2. Choose Configure > Manage Hub Credentials. The Manage Hub Credentials dialog appears.

3. Select the Hub for which you want to update the certificate.

4. Click Update. The Choose a credential file window appears.

5. Browse for the new certificate file and click Open. The file should have a .pem extension.

6. An update message displays in the Manage Hub Credentials dialog.

7. Click Close.

Remove a Hub certificate
You can choose to remove a Hub to which you no longer want the AnyhwereUSB Manager to connect.
After you have removed a Hub certificate, if you have the Auto-register Hub Cert option selected in the
Preferences dialog, a new certificate for the Hub is automatically registered with the AnyhwereUSB
Manager at the next connection attempt or the next time the Hub is discovered by the Manager. If
this option is not selected and you want the AnywhereUSB Manager to connect to the Hub, you can
manually add the Hub to register a new certificate.

1. Open AnywhereUSB Manager.

2. Choose Configure > Manage Hub Credentials. The Manage Hub Credentials dialog appears.

3. Select the Hub that you want to remove.

4. Click Close.

Add a Hub certificate
You can manually add a Hub, which registers the Hub's certificate with the AnywhereUSB Manager.

1. Open AnywhereUSB Manager.

2. Choose Configure > Manage Hub Credentials. The Manage Hub Credentials dialog appears.

3. In the Serial number field, enter the Hub's serial number.
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4. Click Add. The Choose a credential file window appears.

5. Browse for the new certificate file and click Open. The file should have a .pem extension.

6. An update message displays in the Manage Hub Credentials dialog.

7. Click Close.

View latency graph
You can review the relative latency of all of the Hubs connected to the network.

1. Open the AnywhereUSB Manager.

2. Select Help > Latency graph to display the latency graph.

View the AnywhereUSB Manager system messages
You can view the system message log of the AnywhereUSB Manager events. The date and time at
which an event occurred is listed, as well as the event type and additional information. A new log is
created each time you start the AnywhereUSB Manager.
The system message log is used for troubleshooting.

1. Open the AnywhereUSB Manager.

2. Select Help > System Messages. The System Messages dialog appears.
n Click Clear Log to clear the system messages from the log.

n Click Copy to Clipboard to copy the messages to the Windows clipboard. You can then
paste the messages into another application or document.

3. Click Close to close the System Messages dialog.

View AnywhereUSB® Plus license information
You can view license information about the AnywhereUSB® Plus Hub.
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1. Open the AnywhereUSB Manager.

2. Select Help > About. The License dialog appears.

3. Scroll down to review all of the information.

4. Click Close to close the dialog.

Restore AnywhereUSB Manager default configuration
You can restore the AnywhereUSB Manager to the default settings. During this process, you have the
option to keep your currently configured client ID and identity certificate during this process. See
Client ID for more information about how the client ID is used by your computer and the Hub to create
a connection.

n Keep the current client ID

n Change the client ID

Keep the current client ID
To restore the Hub's default settings and keep your currently configured client ID and identity
certificate:

1. Open the AnywhereUSB Manager.

2. Select File > Preferences. The Preferences dialog appears.

3. Click the Setup tab.

4. Click Restore default settings. A dialog appears.

5. Select the Keep Client ID option. This is selected by default.

6. Click OK. The AnywhereUSB Manager closes automatically. The next time you launch the
AnywhereUSB Manager, the default settings will be restored.

Change the client ID
To restore the Hub's default settings and change your currently configured client ID and identity
certificate:

1. Open the AnywhereUSB Manager.

2. Select File > Preferences. The Preferences dialog appears.

3. Click Restore default settings. A dialog appears.

4. De-select the Keep Client ID option.

5. Click OK. The AnywhereUSB Manager closes automatically.

6. Open the AnywhereUSB Manager again. The Client ID confirmation dialog appears.

7. Enter a new, unique client ID. 

8. Click OK. The AnywhereUSB Manager launches.
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Access the online help from the AnywhereUSB Manager
1. Open the AnywhereUSB Manager.

2. Click Help > Online Manual to launch the online help file.

AnywhereUSB Manager window
The AnywhereUSB Manager displays AnywhereUSB® Plus Hubs, groups, and USB devices. Click the
plus sign next to each name in the window to display a hierarchy of found Hubs, groups, and USB
devices.
Information about the icons in the screen and the menu options can be found here:

n AnywhereUSB Manager icons and toolbar

n AnywhereUSB Manager menu options

You can use the menus associated with the Hubs, groups, and USB devices to configure local names,
preferences, and connections. Right-click on a Hub, group, or device name to display the menus.

n AnywhereUSB Manager Hubmenu options

n AnywhereUSB Manager groupmenu options

n AnywhereUSB Manager USB device menu options

Click on a Hub, group, or device name to display information about the selected Hub, group, or device
in the status pane on the right side of the AnywhereUSB Manager.

n AnywhereUSB Manager Hub Status pane

n AnywhereUSB Manager Group Status pane

n AnywhereUSB Manager Device Status pane

AnywhereUSB Manager icons and toolbar
This section explains how to use the icons in the AnywhereUSB Manager and what they represent.
The icons in the AnywhereUSB Manager show the status of a Hub.
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Icon Location Description

Hub Green lock: Active and secure connection between the Hub and the PC.

Hub Yellow dot: The PC and Hub are attempting to connect.

Hub Red X: Connection between the Hub and the PC failed.

The toolbar icons manage the AnywhereUSB Manager dialog.

Icon Description

Minimizes the AnywhereUSB Manager into the task bar and the notification area of
the task bar.

Maximizes the AnywhereUSB Manager.

Minimizes the AnywhereUSB Manager into the notification area of the task bar.

AnywhereUSB Manager menu options
You can use the menu options to view AnywhereUSB® Plus Hub information.

n File > Preferences

n File > Exit

n Configure > Known Hubs

n Configure > Hidden Hubs

n Configure > Manage Hub Credentials

n Help > System Messages

n Help > Latency graph

n Help > Online Manual

n Help > About

AnywhereUSB Manager Hub menu options
Right-click on a Hub name in the AnywhereUSB Manager to configure andmaintain the Hub.

n Open Web UI

n Assign Local Name
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AnywhereUSB Manager group menu options
Right-click on a group name in the AnywhereUSB Manager to configure andmaintain the group.

n Connect to Group

n Disconnect from Group

n Enable Auto Connect

n Disable Auto Connect

n Assign Local Name

AnywhereUSB Manager USB device menu options
Right-click on a USB device name in the AnywhereUSB Manager to configure and connect to the USB
device.

n Connect to Device

n Connect to Group

n Disconnect from Device

n Assign Local Name

AnywhereUSB Manager Hub Status pane
When you select an AnywhereUSB® Plus Hub in the AnywhereUSB Manager, information about the
Hub displays in the Hub Status pane.
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Label Description

State The current state of the Hub. Options are:
n Connecting

n Authenticating

n Active (secure): A green lock icon appears next to the Hub
name.

n Error: If an error has occurred, a red X icon appears next to
the Hub name.

n Duplicate connection: If a Hub that is on the same network
as your computer has been added to the known Hubs list, and
the Autofind Hubs feature is enabled, a duplicate Hub
displays in the AnywhereUSB Manager. The duplicate Hub will
be in the Duplicate connection state. See Manage the list of
known Hubs.

n Unregistered client ID: The client ID is not in the client list for
the Hub. The Hub administrator needs to allow each new
client ID by adding the client ID to the client list.

See AnywhereUSB Manager icons and toolbar for more information
about the Hub icons.

Name The name of the Hub supplied by the Hub. The default value for the
Hub name is the serial number assigned to the Hub. You can change
the Hub name in the Ethernet Network section of the web UI. See
Rename the Hub.

Local Name A descriptive local name for the Hub. The local name also displays in
the tree view in the left-hand pane in the AnywhereUSB Manager.
The local name is local to the computer on which the AnywhereUSB
Manager is running.
You can change the local name using the Assign Local Name menu
option for the Hub.

Model The model name for the AnywhereUSB® Plus Hub.

Version The version number of the firmware running on the Hub.

Address The network address of the Hub.
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Label Description

Serial The serial number of the Hub, which is found on the Hub label.

AnywhereUSB Manager Group Status pane
When you select a group in the AnywhereUSB Manager, information about the group displays in the
Group Status pane.

Label Description

Group No The group number from the Hub.

Group Name The name of the group supplied by the Hub. By default, a group is
named "Group" appended by a consecutive number, such as Group
1, Group 2, and so on.
You can change the group name in the AnywhereUSB screen in the
web UI. See Create groups and assign ports to the group.
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Label Description

Local Name A descriptive local name for the group. The local name also displays
in the tree view in the left-hand pane in the AnywhereUSB
Manager. The local name is local to the computer on which the
AnywhereUSB Manager is running.
You can change the local name using the Assign Local Name menu
option for the group.

Status A status message indicates whether a user is currently connected
this group. Options are:

n You are using this group

n No one is using this group

n In use by <client ID> at <machine name>

AnywhereUSB Manager Device Status pane
When you select a USB device in a group in the AnywhereUSB Manager, information about the device
displays in the Device Status pane.

Label Description

Vendor Name of the USB device vendor, if supplied by the device.

Product Name of the USB product, if supplied by the device.

Local Name A descriptive local name for the USB device. The local name also
displays in the tree view in the left-hand pane in the AnywhereUSB
Manager. The local name is local to the computer on which the
AnywhereUSB Manager is running.
You can change the local name using the Assign a Local Name
menu option for the device. See Assign a local name to a
USB device.

Vendor ID The USB vendor ID.

Product ID The USB product ID.

Address The USB device address that helps to identify a device.
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Label Description

Serial The serial number of the USB device, if supplied by the device.

Status A status message indicates whether a user is currently using this
device. Options are:

n You are using this device

n No one is using this device

n In use by <client ID> at <machine name>

Set Hub preferences
In the AnywhereUSB Manager, you can set preferences for keepalive time messages and responses
and how often the AnywhereUSB Manager searches for a Hub and the Hub response time.
Click File > Preferences to display the Preferences dialog.

Setup tab
n Client ID

n Start Manager minimized

n Autofind Hubs

n Hide unauthorized Hubs

n Auto-register Hub Cert

n Restore default settings
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Advanced tab
Specify search, response, and keepalive intervals for a Hub

Exit the AnywhereUSB Manager
You can log out of the AnywhereUSB Manager close the dialog.

1. Open the AnywhereUSB Manager.

2. Click File > Exit to disconnect all USB devices connected to your computer, close all
connections, and close the AnywhereUSB Manager.

3. If you are connected to any USB devices, a confirmation dialog appears.

4. Click Yes to exit the AnywhereUSB Manager.
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You can configure the AnywhereUSB® Plus Hub in the Configuration and Management web user
interface.
The web UI is available from a Hub listed in the AnywhereUSB Manager. You must install the
AnywhereUSB Manager before you can use the web UI. See Install the AnywhereUSB Manager.
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Open the Configuration and Management web user interface
You can open the Configuration and Management web user interface for a selected AnywhereUSB®
Plus Hub. The information in the web UI is unique for each Hub. Make sure you select the desired Hub
before you open the web UI.
By default, the Home page appears when you open the web UI for a Hub, and displays current Hub
status information. Click Refresh to update the information displayed in the page.

1. Open the AnywhereUSB Manager.

2. Expand AnywhereUSB® Plus Hubs to display the Hubs.

3. Right-click on the Hub that you want to configure or maintain.

4. Click Open Web UI. The Configuration and Management web user interface appears, and
displays the Home page by default.

Note The first time you launch the web UI, a warning dialog may appear if your internet
connection is not private. In this situation, continue to access the device, and a log in dialog
appears. If your internet connection is private, only the log in dialog appears. The user name is
admin and the default password is located on the label on the bottom of the Hub. Note that
the password is case-sensitive andmust be typed in exactly as it appears on the label.

5. Configure or maintain the Hub as needed. See Administrators: Configure the AnywhereUSB®
Plus in the web user interface for more information.

6. When you are done working in the web UI, close the browser window.

Access the online help from the web UI
1. Open the web UI.

2. Click Help > Online Manual to launch the online help file.

Apply and save changes
The web UI runs locally on the device, which means that the interface always maintains and displays
the latest settings for the connected AnywhereUSB® Plus Hub.
When you make a change to the configuration, click Apply to save the changes.

Configuration and Management web user interface
The Configuration and Management web user interface contains a set of pages you can use to
configure andmaintain the AnywhereUSB® Plus Hub.

n Home

Configuration section
n Ethernet Network

n AnywhereUSB

n Network Services

n System

n Time
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n Remote Manager

n Admin Password

Management section
n Connections

Administration section
n Backup/Restore

n Firmware Update

n Factory Default Settings

n System Log

n Find Me LED

n System Statistics

n Reboot

Help
n Online Manual

Configure and manage client IDs
The client list for a Hub displays in the Client Settings section. This list contains all of the client IDs for
the computers that are allowed to connect to the Hub. You can manually add client IDs or choose to
automatically add client IDs to the list.

Note You can have up to 24 client IDs in the client list.

The client IDs are assigned to groups of USB ports on the Hub. When a computer connects to a group
in the AnywhereUSB Manager, the computer has access to all of the ports in the group and the
devices connected to those ports. No other computer is allowed to access any of the devices in the
group. A computer can connect to more than one group at a time.

n Configure a client ID

n Manually add a client ID

n Remove a client ID

n Automatically register or reject unknown clients
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Configure a client ID
You can assign a descriptive name to a client ID in the client list, and update the groups the computer
is allowed to access. The computer can access all of the ports in the specified groups, as defined in the
Group Settings section.

Note If needed, you can also add additional client IDs to the list.

1. Open the web UI.

2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.

3. In the client list in the Client Settings section, select the client ID that you want to configure.
Information about the selected client ID displays in the Settings for Client section.
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4. The Certificate value is Unavailable until certificates have been exchanged between the
computer and the Hub. After this occurs, the Certificate value is updated to Available.

5. In the Description field, enter a descriptive name for the client ID.

6. Click the check box next to a group to which the computer is allowed access. As you select
groups, the selected group numbers appear in the Group Access field in the Settings for
Client section.
You can also manually enter group numbers in the Group Access field.

7. Click Apply to save the changes.

Manually add a client ID
You can manually add client IDs to the client list. When a computer searches for Hubs, any computer
with a client ID on the client list can connect to the Hub.

Note You can have up to 24 client IDs in the client list.

After you have added a client ID, the certificate is unavailable until the first time the computer with
the new client ID connects to the Hub. When the computer connects to the Hub for the first time, the
identity certificates are exchanged between the computer and the Hub. After the initial connection,
only that computer with the client ID and unique identity certificate is able to connect to the Hub. Any
other computer with the same client ID will be rejected. For information about computers with the
same client ID, see AnywhereUSB Manager client ID is not unique.

WARNING! After you have manually added a client ID to the list, Digi recommends that
you use a private network to connect the computer to the Hub and then to verify the
initial connection. If you do not use a private network, and the same client ID is assigned
to both a known and an unknown computer, there is a risk of misidentification. In this
situation, an unknown computer may connect to the Hub before the known computer
does, resulting in the wrong computer being allowed to connect to your Hub.

Note Digi recommends de-selecting the Automatically Register Unknown Clients option if you
choose to manually addmultiple client IDs to the client list. See Automatically reject unknown clients.

1. Open the web UI.

2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.

3. In the Client Settings section, click Add Client. A new row labeled "New Client" is added to
the client list and the Settings for Client section is populated for the new client.
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4. Enter information about the client ID in the Settings for Client "New Client" section.
a. In the Client ID field, enter the client ID for the computer.

b. In the Description field, enter a descriptive name for the client ID.

c. Click the check box next to a group to which the computer is allowed access. As you
select groups, the selected group numbers appear in the Group Access field in the
Settings for Unknown Clients section.

Note The Certificate value is Unavailable until certificates have been exchanged between the
computer and the Hub. After this occurs, the Certificate value is updated to Available.
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5. Click Apply. The client ID is added to the client list.

Remove a client ID
You can remove a client ID from the client list when that computer should no longer have access to
the Hub.

Note If you have selected the Automatically Register Unknown Clients option, any client ID
removed from the list is automatically added to the client list again the next time the computer tries
to connect.

1. Open the web UI.

2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.

3. In the Client Settings section, select the client ID you want to remove from the list.

4. Click Remove. A confirmation dialog appears..

5. Click OK.

Automatically register or reject unknown clients
In the AnywhereUSB Configuration page, you have the choice to automatically register or reject
computers that have not previously connected to the Hub. The Automatically Register Unknown
Clients option is disabled by default, meaning that computers that have not previously connected to
the Hub are rejected.

Note Digi recommends keeping the Automatically Register Unknown Clients option disabled and to
manually add client IDs on a secure network.

n Automatically reject unknown clients

n Automatically register unknown clients

Automatically reject unknown clients
You can choose to have the Hub automatically reject any client ID that is not on the Hub's registered
client list.
You can view which When you open the AnywhereUSB Manager, the Hub is found on the network, but
a red X displays next Hub name, as the client ID is not registered with the Hub. The user is not able to
connect to the Hub.
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Note Digi recommends keeping the Automatically Register Unknown Clients option disabled and to
manually add client IDs on a secure network.

1. Open the web UI.

2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.

3. De-select the Automatically Register Unknown Clients option so the Hub rejects any client
ID that is not on the Hub's registered client list. In this case, a red X displays next to the name
of the Hubs in the AnywhereUSB Manager to which the client ID cannot connect.

4.  Click Apply to save the changes.

Automatically register unknown clients
Select the Automatically Register Unknown Clients option to automatically add the client ID for an
unknown computer to the client list for the Hub. When you open the AnywhereUSB Manager and the
Hub is found on the network, and the user is able to automatically connect to the Hub.
By default, the computer will have access to the ports in the groups specified in the Group Access
field in the Settings for Unknown Clients section. The ports for each group are specified in the Group
Settings section. You can change the groups to which a computer has access in the Client Settings
section.
A user will be able to connect to the Hub in the AnywhereUSB Manager.

1. Open the web UI.

2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.

3. Select the option to automatically add the client ID for an unknown computer to the client list
for the Hub.

4. Click the check box next to the group(s) to which the computer is allowed access. As you select
groups, the selected group numbers appear in the Group Access field in the Settings for
Unknown Clients section.

You can also manually enter group numbers in the Group Access field.

5.  Click Apply to save the changes.

Rename a Hub and the groups in a Hub
A default name is assigned to a Hub and to the groups in the Hub. These names are associated with
the physical Hub and groups on the Hub, and can be changed in the Configuration and Management
web user interface.

Note A USB device does not have a name that can be changed. However, a local name can be
assigned to a USB device in the AnywhereUSB Manager. See Assign a local name to a USB device.

The default Hub name and group name can be see by every user that connects to the Hub. You can
also give a Hub and groups a local name that can be see only by the user that assigns the name. See
Assign a local name to a Hub and Assign a local name to a group.
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Note Only administrators can rename the Hubs and the groups.

n Rename the Hub

n Rename a group

Rename the Hub
You can rename the AnywhereUSB® Plus Hub in the Ethernet Network Configuration page.
By default, the Hub name is the serial number assigned to the Hub. The serial number for the Hub is
on the Hub's label. The Hub name displays in the Name field in the Hub Status pane in the
AnywhereUSB Manager.

Note The name can consist of the following characters: 0-9, A-Z, a-z, dash (-), or period (.). You cannot
use spaces, underscores (_), comma (,), forward slash (/), or ampersand (&).

1. Open the web UI.

2. Select Ethernet Network from the Configuration section. The Ethernet Network
Configuration dialog appears.

3. In the Host Name field, enter a descriptive name for the Hub. The name cannot have spaces or
underscores.

4. Click Apply.

Rename a group
You can rename the AnywhereUSB® Plus Hub in the AnywhereUSB page in the web UI.
By default, a group is named "Group" appended by a consecutive number, such as Group 1, Group 2,
and so on. The group name displays in the Group Name field in the Group Status pane in the
AnywhereUSB Manager.

1. Open the web UI from your selected Hub.

2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.

3. Enter a new name for a group in the Group Description field.

4. Click Apply to save the changes.

View Hub system information
You can view current status information about the Hub in the System Information page. This page
appears by default when you launch the web UI.
The Description, Contact, and Location fields are populated after you have entered identity settings
in the System Configuration page. See Configure device identity settings.

1. Open the web UI. This page appears by default when you launch the web UI.

2. Click Home. The System Information page appears.

3. Click Refresh to update the information in the page.
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Configure the IP address on the Hub
You can configure the IP address for the Hub in the Ethernet Network Configuration page. You can
choose to enable the Hub to automatically obtain an IP address, or you can manually assign an IP
address.

n Automatically obtain an IP address for the Hub

n Manually set an IP address for the Hub

Automatically obtain an IP address for the Hub
In the Ethernet Network Configuration page, you can configure the Hub to automatically obtain an
IP address each time you power on the Hub.
The Obtain an IP address automatically using DHCP option is enabled by default. DHCP is used to
automatically assign IP addresses; deliver TCP/IP stack configuration parameters, such as the subnet
mask, default gateway and domain name servers; and to provide other configuration information.
When the Obtain an IP address automatically using DHCP option is enabled, but if the DHCP server
is unavailable or nonexistent, Auto-IP assigns the device an IP. Auto-IP (Auto Private IP Addressing
(APIPA)), is a standard protocol that automatically assigns an IP address from a reserved pool of
standard Auto-IP addresses to the computer on which it is installed. If DHCP is enabled or responds
later, the IP address assigned by DHCP overrides the Auto-IP address that was previously assigned.

Note If the Obtain an IP address automatically using DHCP option is disabled, the Use the
following IP address option is enabled by default, and you must manually set an IP address.

1. Open the web UI.

2. Select Ethernet Network from the Configuration section. The Ethernet Network
Configuration dialog appears.

3. Select the Obtain an IP address automatically using DHCP option.

4. The values in the Primary DNS and Secondary DNS fields are automatically assigned.

5. Click Apply.

Manually set an IP address for the Hub
You can manually assign a specific IP address for the AnywhereUSB® Plus Hub in the Ethernet
Network Configuration page.

1. Open the web UI.

2. Select Ethernet Network from the Configuration section. The Ethernet Network
Configuration dialog appears.

3. Select the Use the following IP address option.

4. Enter the appropriate values in the IP Address, Subnet Mask, and Default Gateway fields.

5. Enter the appropriate values in the Primary DNS and Secondary DNS fields.

6. Click Apply.
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Ethernet network bonding
For the AnywhereUSB 24 Plus Hub, you can specify the bonding mode for the Ethernet network. The
Hub has two physical Ethernet network ports that use the same MAC address and share one IP
address. When both ports are being used, they act as one Ethernet network port.

Note This applies to the AnywhereUSB 24 Plus only.

1. Open the web UI.

2. Select Ethernet Network from the Configuration section. The Ethernet Network
Configuration dialog appears.

3. In the Ethernet Network Bonding section, select the bonding option that you want to use.
Bonding is used when Ethernet cables are connected to both Ethernet network ports.

n Load Balancing (Round-Robin): The Ethernet network connection alternates between
the two ports as the Hub sends data. If one Ethernet network connection fails, all data
is sent from the second Ethernet network connection.

n Fault-Tolerance (Active-Backup): The Hub uses only one of the Ethernet network
connections at a time. If one Ethernet network connection fails, all data is sent from the
second Ethernet network connection. This is the default.

4. Click Apply.

Change the Hub password
You can change the administrator password for the Hub in the Admin Password Management page.

Note The default password is included on the Hub's label, andmust be entered the first time you
connect to the Hub from the web UI.

After you change the password, you must log in before you can access any pages in the web UI.
1. Open the web UI.

2. Click Admin Password in the Configuration section. The Admin Password Management page
appears.

3. In the Current Password field, enter the current password.

4. In the New Password field, enter the new password.

5. In the Confirm Password field, re-enter the new password.

6. Click Apply to apply and save the change.

7. Select any link in the web UI. A log in dialog appears.

8. Log in using the new password.
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View current connections to the Hub
You can view information about current connections to the Hub in the Connections Management
page.

1. Open the web UI.

2. Click Connections in the Management section. The Connections Management page appears.
n Local Address: The IP address of the Hub and the TCP port number of a network

service running on the Hub. The TCP Port information is available on the Network
Service Configuration page.

n Remote Address: The IP address of the computer connected to the Hub.

n Service: A description of the service connected to the Hub.

3. Click Refresh to update the information in the screen.

Configure network services
You can configure network services options in the Network Service Configuration page. All network
services options are selected by default.
For each service you must specify the TCP port number. The ports are configured by default, and
changing the default value is not recommended.

1. Open the web UI.

2. Click Network Services in the Configuration section. The Network Service Configuration
page appears.
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3. Select the Enable option for the network service you want to enable.
n Multicast Domain Name System (MDNS): Enables the discovery of the Hub on the local

network.

n Enable AnywhereUSB: Allows remote access to USB devices connected to this server.
The default TCP Port value is 18574.

n Enable Secure Shell Server (SSH): Allows users secure access to log in to the Digi
device and access the command line interface. The default TCP Port value is 22.

n Enable Web Server (HTTP): Enables web pages for configuration. The default TCP Port
value is 80.

n Enable Secure Web Server (HTTPS): Enables web page encryption to improve the
security of web data transfers. The default TCP Port value is 443.

4. Enter the port number in the TCP Port field. If you change the port number on this screen, you
must also change the corresponding port number on your computer.

5. Click Apply to apply and save the changes.

Configure the findme feature
You can use the findme feature to cause an LED on the Hub to blink, which can help you to identify a
specific Hub.

n AnywhereUSB 2 Plus: When enabled, the power LED blinks green, then orange.

n AnywereUSB 8 Plus and AnywhereUSB 24 Plus: When enabled, the user LED blinks green,
then orange.

Note You can also configure this feature using the findme CLI command.

1. Open the web UI.

2. Click Find Me LED in the Administration section. The Find Me LED page appears.

3. Click Activate. The "Find Me LED Status" message changes to blinking, and the message "The
Find Me LED is blinking" appears at the top of the page. The appropriate LED on the Hub begins
to blink.
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4. When you have found the Hub, click Stop. The "Find Me LED Status" message changes to not
blinking, and the message "The Find Me LED is stopped" appears at the top of the page.

Configure device identity settings
You can configure the device description, contact, and location information for the Hub in the System
Configuration page. This feature is useful to identify a specific Hub when working with a large
number of Hubs in multiple locations. The information entered on this page appears in the Home
page.

1. Open the web UI.

2. Click System from the Configuration section. The System Configuration page appears.

3. Enter the following information:
n Description: An identifying description of the Hub.

n Contact: Any contact information for a person that can manage the Hub, such as the
administrator name and contact information.

n Location: The physical location of the Hub.

4. Click Apply to apply and save the changes.

Allow the Hub to connect to Remote Manager
You can use Digi® Remote Manager to view your Hubs andmanage the information sent from the Hub
to Remote Manager. By default, the Hub is configured to connect to Remote Manager, and Remote
Manager is configured to allow a connection with the Hubs.
You can enable access for the Hub to Remote Manager and specify reconnect time and keepalive
intervals in the Remote Manager Configuration page. You can view information about the connection
to Remote Manager in the System Statistics page and in the Connections Management page.
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Note You must have a Remote Manager account and add the Hub to Remote Manager to be able to
view the Hub data in Remote Manager. For more information, see View Hub information in Remote
Manager.

To enable access to Remote Manager for the Hub:
1. Open the web UI.

2. Click Remote Manager in the Configuration section. The Remote Manager Configuration
page appears.

3. Select Enable Remote Manager Connectivity. This option is selected by default.

4. In the Remote Manager Server field, enter the name of your Remote Manager server. A value
is entered by default.

5. Enter the following information:
n Reconnect Time: The amount of time to wait after the Hub has been disconnected from

Remote Manager before the Hub should automatically try to reconnect. The time is
measured in seconds. The default is 30 seconds.

n Device keepalive interval: The interval at which the Hub sends a keep-alive packet to
Remote Manager if the Remote Manager connection is idle. Remote Manager expects
to receive either Remote Manager protocol messages or keep-alive packets at the
specified interval. The time is measured in seconds. The default is 60 seconds.

n Server keepalive interval: The interval at which Remote Manager sends a keep-alive
packet to the Hub if the Remote Manager connection is idle. The Hub expects to receive
either Remote Manager protocol messages or keep-alive packets at the specified
frequency. The time is measured in seconds. The default is 60 seconds.

n Maximum missed keepalives: The number of consecutive keep-alives can be missed
before the connection between Remote Manager and the Hub is considered lost and
subsequently closed by the Hub and Remote manager. The default is 3.

6. Click Apply to apply and save the change.

7. To ensure your connection to Remote Manager, see View Hub information in Remote Manager
for details about adding the Hub to Remote Manager.

Backup and restore settings
The backup and restore feature allows you to save any configuration changes you have made to a file,
and then restore a configuration by applying the saved changes to any Hub.

n Backup: The back up file contains only the configuration changes you have made from the
default settings. The entire configuration of a Hub is not saved.

n Restore: When you restore a configuration, the changes saved to the backup file are applied
over any other existing changes on the Hub.

When configuration of a Hub is complete, it is recommended that you back up that configuration in
case you need to revert to a desired configuration.
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You can also use the backup/restore feature as a convenience when configuring multiple Hubs. You
can back up the first Hub's configuration settings, and then apply that back up file to other Hubs.
The format of the back up file is a list of CLI commands.

Back up a Hub's configuration
Only the changes made from the default configuration are saved to the back up file.

1. Open the web UI.

2. Click Backup/Restore from the Administration section. The Backup/Restore page appears.

3. Click Backup to back up the Hub's current configuration to a back up file.

4. A confirmation dialog appears. Save the change to continue.

Restore the configuration for a Hub
You can apply a previously saved backup file from a Hub to the same Hub or any other Hub.

Note The backed up changes are applied on top of the current settings for the Hub.

1. Open the web UI.

2. Click Backup/Restore from the Administration section. The Backup/Restore page appears.

3. Click Choose File to select a backup file that you previously saved.

4. Click Restore to apply the selected backup file to the Hub.

Update the firmware
You can update the firmware on a Hub from the Update Firmware page. Information about the
current version of the firmware appears in the screen.
You must first get the current firmware file, and then you can upload it to the Hub.

Download the firmware to your computer
1. Go to www.digi.com/support.

2. Scroll down to the Support Downloads section.

3. Click Firmware Updates.

4. In the Filter the list box, enter AnywhereUSB Plus. As you type, matches display.

5. Click AnywhereUSB Plus.

6. From the list of options, select the option for your model: AnywhereUSB 2 Plus,
AnywhereUSB 8 Plus, or AnywhereUSB 24 Plus.

7. From the Firmware Updates section, select the version you want to download. The file is
downloaded to a folder on your computer. Make a note of the folder path and name.

http://www.digi.com/support
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Update the firmware on the Hub
1. Open the web UI.

2. Click Firmware Update from the Administration section. The Update Firmware page appears.

3. Click Choose File and browse for the firmware file.

4. Click Update. The USB port 1 LED flashes while the firmware is being updated.

5. When the update is complete, a status message appears.

Note DO NOT close the browser until the update is complete and the status message appears.

6. The device automatically reboots. When the reboot is complete, all the LEDs light up.

View system logs
You can view information from the device log files in the System Message Log File Browser screen.
The log files are mainly used for troubleshooting.

1. Open the web UI.

2. Click System Log in the Administration section. The System Message Log File Browser page
appears.

3. From the Select Log File list box, select the log file that you want to view. The eventlog.txt file
is selected by default.

4. Click Get File. The messages in the log file display in the Messages in Log File section.

5. The filters that relate to the log file option you selected appear in the Messages in Log File
section. All filters are selected by default. You can:

n Select and de-select individual filters.

n Click Clear All to de-select all of the filters.

n Click Mark All to select all of the filters.

As you select and de-select filters, the Message Filters for Displayed Log File section is
updated.

6. Click Refresh to update the messages that appear in the Message Filters for Displayed Log
File section.

7. Click Save All to save the messages in a .txt file. The file is downloaded so you can access the
file.

View system statistics
The System Statistics page displays statistical information for these connections: ethernet, IP, TCP,
UDP, and ICMP. Remote Manager connection information is also displayed.
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1. Open the web UI.

2. Click System Statistics in the Administration section. The System Statistics page apears.

3. Click Refresh to update the information.

Configure the time on the Hub
By default, the time on the Hub is the last time stamp that was written to the Hub log file. To ensure
that the time on the Hub is correct, you should configure the time in the Time Configuration page.
You can choose to either manually set the time on the Hub to match the time on the server, or to
configure time server synchronization.

n Configure time server synchronization: Synchronize the time on the Hub with the NTP
(Network Time Protocol) servers.

n Set the server time manually: Manually set the time for the Hub. This overrides the NTP time
synchronization.

Configure time server synchronization
You can use this method to synchronize the time on the Hub with the NTP (Network Time Protocol)
servers. This method is the default, and the information for the NTP servers is configured by default.

Note Digi recommends using NTP.

1. Open the web UI.

2. Click Time in the Configuration section. The Time Configuration page appears.

3. Select Enable Time Server Synchronization. This option is selected by default.

4. From the Timezone drop-down, select the time zone the server is in.

5. Click Apply to apply and save the change.

Set the server time manually
You can use this method to manually set the time for the Hub. This overrides the NTP time
synchronization. See Configure the time on the Hub.
If you use this method, and the Hub has lost power (both external and internal), or if you reboot the
Hub, the Set Time option is de-selected and the time reverts to the last time stamp that was written
to the Hub log file. If you want to more accurately set the time, you should either configure time
server synchronization or manually re-set the time using the process below.

Note Digi recommends using NTP. See Configure time server synchronization.

To manually set the time:
1. Open the web UI.

2. Click Time in the Configuration section. The Time Configuration page appears.

3. If the Enable Time Server Synchronization option is selected, de-select it.

4. Select Set Time in the Time Settings section. This enables you to manually set the time.
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5. Specify the current date and time for the server in the Month, Day, Year, Hour, Minute, and
Second fields.

6. From the Timezone drop-down, select the time zone the server is in.

7. Click Apply to apply and save the change.

Restore factory default settings from the web UI
You can use the Factory Default Settings operation from the web UI to reset the configuration of a
Hub to the factory default settings. The restore process clears all current settings (including all
previously stored client IDs and certificates), deletes all Hub and AnywhereUSB Manager keys, resets
the password for the administrative user, and restores the settings to the factory defaults.
When restoring the Hub to the factory defaults from the web UI, you can choose to retain the stored
IP configuration, which is configured on the Ethernet Network Configuration page.

Note You can also use the factory-default CLI command for all Hubmodels, and the Reset button on
the Hub to restore the factory default settings. Note that these methods do not allow you choose
whether you want to retain the stored IP configuration.

1. Open the web UI.

2. Make a backup copy of the configuration using the Backup/Restore operation to save the
current configuration in case you want to restore it at a later time.

3. Click Factory Default Settings from the Administration section. The Factory Default Settings
page appears.
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4. Determine whether you want to retain the current DHCP andmanual configuration settings. IP
configuration option: automatic (automatically obtain an IP address each time you power on
the Hub) or static (manually assign an IP address).

n Do not select the Keep Stored IP Configuration option to remove the current IP
configuration option. In this situation, the DHCP (Auto IP) process is used. For more
information about DHCP and Auto IP, see Automatically obtain an IP address for the
Hub. This is the default.

n Select the Keep Stored IP Configuration option to retain the current IP configuration
option. The IP, netmask, gateway, and DNS values will be used for the network
configuration. These manual values are kept in the configuration settings even if you
are currently using DHCP, so you can flip back and forth.

5. Click Restore. The Hub is rebooted.

6. You must re-deploy the Hub.

Reboot the Hub
You can reboot the Hub if needed. For example, changes to some Hub settings require saving the
changes and rebooting the Hub for the changes to take effect on the Hub.

Note If the Set Time option is selected in the Time Configuration page, and the Hub is rebooted, the
Set Time option is de-selected and the time reverts to the last time stamp that was written to the
Hub log file. If you want to more accurately set the time, you should either configure time server
synchronization or manually re-set the time.

1. Open the web UI.

2. Select Reboot from the Administration section. The System Reboot Confirmation page
appears.

3. Click Reboot.

4. Wait approximately 15 seconds for the reboot to complete. When the reboot is complete, all
the LEDs turn on and then turn off, leaving the power LEDs on. For the AnywhereUSB 24 Plus
model, one or both of the power LEDs will be on.

Uninstall the AnywhereUSB Manager
You can uninstall the AnywhereUSB Manager if needed.

1. Locate the AnywhereUSB Manager installer.
n If you saved the installer when you originally installed the AnywhereUSB Manager,

navigate to that location on your computer.
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n If you did not, you can download the installer from the Support Tools website.
a. Navigate to https://www.digi.com/support#support-tools.

b. From the Support Downloads section, click Drivers.

c. Find and select AnywhereUSB Plus from the product list.

d. Select your AnywhereUSB Plus model.

e. Select and download the appropriate software for your operating system.

2. Click on the downloaded software to launch the AnywhereUSB Manager installation wizard.
The Welcome screen appears.

3. Click Next. The Program Maintenance screen appears.

4. Select Remove.

5. Click Next. The Remove the Program screen appears.

http://www.digi.com/support/product-support
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6. Determine whether you want to remove the AnywhereUSB® Plus configuration settings that
you have selected.

n Do not select Remove User Configuration: The configuration settings you have made
are retained and re-applied the next time you install the AnywhereUSB Manger.

n Select Remove User Configuration: The configuration settings you have made are not
retained and removed with the program.

7. Click Remove. If the AnywhereUSB Manager is open, the following dialog displays. Do not
change the default settings.

8. Click OK. A progress bar appears.

9. When the uninstall is complete, the InstallShield Wizard Completed screen appears.
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10. Click Finish to complete the uninstall and close the dialog.



View Hub information in Remote Manager

By default, an AnywhereUSB® Plus Hub is configured to allow a connection between the Hub and
Remote Manager.

n For information about enabling a Hub to connect to Remote Manager, see Allow the Hub to
connect to Remote Manager for more information.

n For information about accessing Remote Manager and adding a Hub to Remote Manager, see
Get started with Remote Manager.

For more information about Remote Manager in general, see the Digi Remote Manager User Guide.

Get started with Remote Manager
Before you can access an AnywhereUSB® Plus Hub in Remote Manager, you must be able to access
your account in Remote Manager, and then add the Hub to the list of devices that are monitored by
Remote Manager.

1. Log into your Remote Manager account. For information about creating a Remote Manager
account and logging in, see the Get Started section in the Digi Remote Manager User Guide.

2. Add the Hub to the list of devices monitored by Remote Manager.

For more detailed information about using Remote Manager, see the Digi Remote Manager User Guide.

Update the firmware on the Hub from Remote Manager
You can update the firmware on an AnywhereUSB® Plus Hub from Remote Manager. You must first get
the current firmware file, and then you can upload it to the device.

1. Download the firmware to your computer.

2. Log into your Remote Manager account. For information about creating a Remote Manager
account and logging in, see the Get Started section in the Digi Remote Manager User Guide.

3. Click Device Management.

4. From the list of devices, click on the Hub for which you want to update the firmware.

5. In the toolbar, click More > Update Firmware. The Update Firmware dialog appears.

6. Click Browse to select the firmware file you just downloaded.
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http://www.digi.com/resources/documentation/digidocs/90001150/default.htm
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm#containers/cont_getting_started_rm.htm%3FTocPath%3DGet%2520Started|_____0
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm#tasks/t_add_devices_manually.htm%3FTocPath%3DDevice%2520management|Add%2520devices%2520to%2520Remote%2520Manager|_____1
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm#containers/cont_getting_started_rm.htm%3FTocPath%3DGet%2520Started|_____0
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm
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7. Click Update Firmware to immediately update the firmware. The updated Hubs will
automatically reboot when the updates are complete.

Note By default, the firmware will update when you click the Update Firmware button. If you
want to schedule when you want the update to occur, click the gear icon to display the options.
See Schedule an action in the Digi Remote Manager User Guide for detailed information about
the schedule options.

View identifying information about the Hub on the Home page
You can display information about the Hub in the Home page, such as the IP address, global address,
and the Hub device ID. From this page you can also view the Hub data stream and device file.

1. Log into your Remote Manager account. For information about creating a Remote Manager
account and logging in, see the Get Started section in the Digi Remote Manager User Guide.

2. Click Device Management.

3. From the list of devices, click on the AnywhereUSB® Plus Hub for which you want to view
identifying information.

4. Click Properties in the toolbar. The Home page for the Hub appears.

View Hub summary dashboard
Remote Manager tracks connection history between an AnywhereUSB® Plus Hub and Remote
Manager. You can a graph of the connection information. See View Hub connection history for detailed
information.

1. Log into your Remote Manager account. For information about creating a Remote Manager
account and logging in, see the Get Started section in the Digi Remote Manager User Guide.

2. Click Device Management.

3. From the list of devices, click on the AnywhereUSB® Plus Hub for which you want to view
connection history.

4. Click Properties in the toolbar. The Home page for the Hub appears.

5. Click Summary Dashboard in the left pane. The connection history graph for the Hub displays.

View Hub connection history
Remote Manager tracks and displays a detailed connection history between an AnywhereUSB® Plus
Hub and Remote Manager. You can view connection and disconnection times, connection methods,
and disconnect reasons. See View Hub summary dashboard for a graph of the connection history.

1. Log into your Remote Manager account. For information about creating a Remote Manager
account and logging in, see the Get Started section in the Digi Remote Manager User Guide.

2. Click Device Management.

3. From the list of devices, click on the AnywhereUSB® Plus Hub for which you want to view
connection history.

https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm#tasks/t_schedule_options.htm
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm#containers/cont_getting_started_rm.htm%3FTocPath%3DGet%2520Started|_____0
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm#containers/cont_getting_started_rm.htm%3FTocPath%3DGet%2520Started|_____0
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm#containers/cont_getting_started_rm.htm%3FTocPath%3DGet%2520Started|_____0
https://www.digi.com/resources/documentation/digidocs/90001436-13/default.htm
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4. Click Properties in the toolbar. The Home page for the Hub appears.

5. Click Connection History in the left pane. The connection history for the Hub displays.



Configure the AnywhereUSB Manager from the
command line

You can configure and control the AnywhereUSB Manager from the command line.

Prerequisites
n Service: If you run the AnywhereUSB Manager as a service, you need to be an Administrator.

n Stand-alone: If you run the AnywhereUSB Manager as a stand-alone, you need to be the same
user that was logged in during the installation process or an Administrator. If you are not an
Administrator, and you try to configure the AnywhereUSB Manager from a command line with
the "Run as Administrator" option selected, the commands will fail.
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autoconnect clear all

Purpose
Disables the auto connect feature for all Hubs, groups, and devices. When complete no asterisks or
plus signs display next to Hub, group, or device names.

Syntax
>awusbmanager autoconnect clear all

Examples
Run the list command to verify the current state of the auto-connect feature for the Hubs, groups, and
devices. In this example, Group 1 has auto connect enabled, and the device in Group 1 has inherited
the auto connect feature.

AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
Group 2 (AW02-000001.2)

* Group 1 (AW02-000001.1) (In-use by you)
+ U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service

Run the autoconnect clear all command.

>awusbmanager autoconnect clear all

Run the list command again to verify that the auto connect feature has been disabled. No asterisks or
plus signs should display.

AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
Group 2 (AW02-000001.2)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service
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autoconnect clear group

Purpose
Disable the auto connect feature for a specified group.
When you disable auto connect for a group, an asterisk no longer displays next to the group name. In
addition, any devices in the group no longer inherit the auto connect feature, and the plus sign no
longer displays next to the device names.

Note For more information about auto connect, see Configure auto connect.

Syntax
>awusbmanager autoconnect clear group,<address>

The [address] is the address of the group for which you want to disable the auto connect feature.

Examples
Run the list command to verify the current state of the auto-connect feature for a group and to
determine the address for a group. In this example, Group 1 has the auto connect feature enabled, so
an asterisk displays next to the group name.
The [address] for a group is the name of the Hub appended by the number of the group. In this
example, the auto connect feature will be disabled for Group 1, so the group name is highlighted
below.

AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
Group 2 (AW02-000001.2)

* Group 1 (AW02-000001.1) (In-use by you)
+ U3 Cruzer Micro (AW02-000001.1101) (In-use by you)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service

Run the autoconnect clear group command.

>awusbmanager autoconnect clear group,AW02-000001.1

Run the list command again to verify that the auto connect feature has been disabled. In this example,
the auto connect feature has been disabled for Group 1, so an asterisk no longer displays next to the
group name. In addition, the plus sign no longer displays next to the devices in Group 1.

Note If you were connected to the group and the devices in the group, you will still be connected. If
you want do disconnect from them, you can use the disconnect group command.

AnywhereUSB Manager, below are the available devices:
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AW02-000001 (AW02-000001.local.:18574)
Group 2 (AW02-000001.2)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101) (In-use by you)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service
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autoconnect group

Purpose
Enable the auto connect feature for a specified group. This feature ensures that when you start the
AnywhereUSB Manager as a stand-alone or when it starts at Windows startup if installed as a
service, you are automatically connected to all of the groups to which you are allowed access that
have auto connect enabled.
When you enable auto connect for a group, an asterisk displays next to the group name. In addition,
any devices in the group inherit the auto connect feature, and will also be automatically connected. A
plus sign displays next to the devices when the auto connect feature is inherited.
You can disable the auto connect feature for the group if needed.

Note For more information about auto connect, see Configure auto connect.

Syntax
>awusbmanager autoconnect group,<address>

The [address] is the address of the group for which you want to enable the auto connect feature.

Examples
Run the list command to verify the current state of the auto-connect feature for a group and to
determine the address for a group. In this example, Group 2 has the auto connect feature enabled, so
an asterisk displays next to the group name. The auto connect feature is not enabled for Group 1, so
an asterisk does not display.
The [address] for a group is the name of the Hub appended by the number of the group. In this
example, the auto connect feature will be enabled for Group 1, so the group name is highlighted
below.

AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
* Group 2 (AW02-000001.2) (In-use by you)

Group 1 (AW02-000001.1) (In-use by you)
U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service

Run the the autoconnect group command.

>awusbmanager autoconnect group,AW02-000001.1

Run the list command again to verify that the auto connect feature has been enabled. An asterisk
displays next to the group name. A plus sign displays next to the names of the devices in the group to
show that the auto connect feature is inherited from the group.
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AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
* Group 2 (AW02-000001.2) (In-use by you)
* Group 1 (AW02-000001.1) (In-use by you)
+ U3 Cruzer Micro (AW02-000001.1101( (In-use by you)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service
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autofind

Purpose
Enables and disables the autofind feature. When enabled, all Hubs connected to the network when
AnywhereUSB Manager launches are automatically found. This command works as a toggle, or you
can can specify "on" or "off." Before you used the command, you should verify the status of the
autofind feature.
The status of the autofind feature is displayed when you run the list command.

Note For information about this feature in the AnywhereUSB Manager, see Autofind Hubs when the
AnywhereUSB Manager launches.

Syntax
>awusbmanager autofind[,on|,off]

n on: Enables the autofind feature. When enabled, all Hubs connected to the network when
AnywhereUSB Manager launches are automatically found. This option is not required.

n off: Disables the autofind feature. When disabled, Hubs are not automatically found when
AnywhereUSB Manager launches. In this case, you must manually add the Hubs to which you
want to connect to the known Hubs list. This option is not required.

Examples
Run the list command to verify the status of the autofind feature. In this example, the autofind feature
is enabled.

AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service

Run the autofind command to disable the feature. You can specify the "off" option, but it is not
required.

>awusbmanager autofind,off

Run the list command again.

AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
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Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: disabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service

You can run the autofind command again to enable the feature. You can specify the "on" option, but it
is not required.

>awusbmanager autofind

Run the list command again to verify.

AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service
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connect device

Purpose
Connect to a USB device in a group to which you have access. You cannot connect to a device in a
group that is already in use.
You must be connected to the group before you can connect to a device in that group. If the device
requires a password, you must enter the password when using the connect device command.

Syntax
>awusbmanager connect device,<address>[,password]

The <address> is the address of the device to which you want to connect.
The <password> is the password for the device. The password is optional.

Examples
If you have connected to a group, and then disconnect from a device in that group, you no longer have
access to the device. You can reconnect to that device.
Run the list command to make sure you are connected to the group that the device you want to
connect to is in. In this example, the device is in Group 1, so you should be connected to Group 1.
You will need the address for device to which you want to connect.

AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service

Run the connect device command. If required to access the device, include the device password.

>awusbmanager connect device,AW02-000001.1101

Run the list command again to verify that the device is connected.

AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101) (In-use by you)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled



Configure the AnywhereUSB Manager from the command line connect device

AnywhereUSB® Plus User Guide for versions 3.x and below 89

Autoconnect All: disabled
AnywhereUSB Manager not running as a service
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connect group

Purpose
You can connect to a group so that you have access to the ports in the group. Once you have
connected to a group, no one else can connect to that group. You cannot connect to a group that is
already is use.
When you connect to a group, you are automatically connected to all of the ports in the group to which
you are allowed access.

Syntax
>awusbmanager connect group,<address>

The [address] is the address of the group to which you want to connect.

Examples
Run the list command to determine the address for the group to which you want to connect. In this
example, you will connect to Group 1.

AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1)

U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service

Run the connect group command.

>awusbmanager connect group,AW02-000001.1

Run the list command again to verify that you are connected to the group and to all of the ports in the
group to which you are allowed access.

AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101) (In-use by you)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service
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device info

Purpose
Displays information about a device. For more information, see AnywhereUSB Manager Device Status
pane.

Syntax
>awusbmanager device info,<address>

The [address] is the address of the device for which you want to display information. The address is
required.

Examples
Run the list command to determine the device's address.

AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
* Group 2 (AW02-000001.2) (In-use by you)
* Group 1 (AW02-000001.1) (In-use by you)
+ U3 Cruzer Micro "USB stick 1" (AW02-000001.1101) (In-use by you)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service

Run the device info command.

>awusbmanager device info,AW02-000001.1101

Information about the device displays.

ADDRESS: AW02-000001.1101
LOCALNAME: USB stick 1
VENDOR: SanDisk
VENDOR ID: 0x0781
PRODUCT: U3 Cruzer Micro
PRODUCT ID: 0x5406
SERIAL: 0770000F0000000C
AUTOCONNECT: inherited
IN USE BY: YOU
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device name

Purpose
Change or assign the local name of a device.

Syntax
>awusbmanager device name,<address>,<new name>

The <device name> is the device's address.
The <new name> is the new local name for the device.

Examples
Run the list command to determine the device's address.

AnywhereUSB Manager, below are the available devices:

AW02-000001 "Hub 1" (AW02-000001.local.:18574)
Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service

Run the device name command.

>awusbmanager device name,AW02-000001.1101,USB Stick

Run the list command again to verify the name change.

AnywhereUSB Manager, below are the available devices:

AW02-000001 "Hub 1" (AW02-000001.local.:18574)
Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro "USB Stick" (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service
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disconnect device

Purpose
Disconnect from a USB device to which you no longer need access. You will remain connected to the
group that the device is in. Other users cannot connect the USB device, since you still own the group
that the USB device is in.

Note If you have auto connect enabled for the group, you can disconnect from a USB device in the
group, but note that for a stand-alone, the device will be reconnected the next time you stop and then
start the AnywhereUSB Manager. If you are running the AnywhereUSB Manager as a service, the
device remains disconnected until you reboot the PC or restart the service.

Syntax
>awusbmanager disconnect device,<address>

The <address> is the address of the device from which you want to disconnect.

Examples
Run the list command to view the address for device from which you want to disconnect.

AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101) (In-use by you)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service

Run the disconnect device command.

>awusbmanager disconnect device,AW02-000001.1101

Run the list command again to verify that the device is disconnected.

AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service
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disconnect group

Purpose
You can disconnect from a group that has ports you no longer need access to. You are disconnected
from all USB devices and ports in that group. Any other user can then connect to that group.

Note If the group has auto connect enabled, and you want to disconnect from the group, note that
when you disconnect from the group you will be automatically reconnected. Before you disconnect,
make sure that auto connect is disabled for the group.

Syntax
>awusbmanager disconnect group, [address]

The [address] is the address of the group from which you want to disconnect.

Examples
Run the list command to determine the address for the group to which you want to connect.
Make sure that auto connect is disabled for the group. When it is disabled, an asterisk does not display
next to the group name. If you need to disable auto connect for the group, see autoconnect clear
group.

AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101) (In-use by you)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service

Run the disconnect group command.

>awusbmanager disconnect group,AW02-000001.1

Run the list command again to verify that the group is disconnected.

AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1)

U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
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Autoconnect All: disabled
AnywhereUSB Manager not running as a service
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exit

Purpose
Shuts down the service. If the AnywhereUS Manager is open, it is shut down as well.

Syntax
>awusbmanager exit
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group info

Purpose
Displays information about a group. For more information, see AnywhereUSB Manager Group Status
pane.

Syntax
>awusbmanager group info,[address]

The [address] is the address of the group for which you want to display information. The address is
required.

Examples
Run the list command to determine the group's address.

AnywhereUSB Manager, below are the available devices:

AW02-000001 "HUB-000001" (AW02-000001.local.:18574)
* Group 2 "Admin group" (AW02-000001.2) (In-use by you)

Group 1 (AW02-000001.1) (In-use by you)
U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service

Run the group info command.

>awusbmanager group info,AW02-000001.2

Information about the group displays.

ADDRESS: AW02-000001.2
LOCALNAME: Admin group
GROUP: 2
NAME: Group 2
PORTS: 2
AUTOCONNECT: enabled
IN USE BY: YOU
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group name

Purpose
Change or assign the local name of the group.

Syntax
>awusbmanager group name,<address,<new name>

The <group name> is the group's address.
The <new name> is the new local name for the group.

Examples
Run the list command to determine the group's address.

AnywhereUSB Manager, below are the available devices:

AW02-000001 "Hub 1" (AW02-000001.local.:18574)
Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service

Run the group name command.

>awusbmanager group name,AW02-000001.2,New Group

Run the list command again to verify the name change.

AnywhereUSB Manager, below are the available devices:

AW02-000001 "Hub 1" (AW02-000001.local.:18574)
Group 2 "New Group" (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service
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hidden hub add

Purpose
Hide a Hub by adding it to the hidden Hubs list.

Note For information on hiding Hubs in the AnywhereUSB Manager, see Hide an individual Hub and
Hide all unauthorized Hubs.

Syntax
>awusbmanager hidden hub add,<address>[:port]

The [address] is the address of the Hub that you want to hide
The <port> is the TCP port number for the Hub you want to hide. This is required if the TCP port
number is not the default (18574).

Examples
Run the hidden hub add command to add a Hub to the hidden Hub list.

n Use the default port of 18574:

>awusbmanager hidden hub add,10.10.10.34

n Change the TCP port number:

>awusbmanager hidden hub add,10.10.10.56:5600

You can then run the hidden hub list command to verify that the Hubs were added to the list of
hidden Hubs.

10.10.10.34:18574
10.10.10.56:5600
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hidden hub list

Purpose
Displays a list of Hubs that have been added to the hidden Hubs list.

n You can choose to hide Hubs that currently display in the AnywhereUSB Manager, such as an
unauthorized Hub (which displays with a red X next to the Hub name), or a Hub which users
shouldn't access.

n You can also choose to hide Hubs that don't currently display in the AnywhereUSB Manager,
but the client ID may have access in the future, such as a Hub on another network.

Note For information on hiding Hubs in the AnywhereUSB Manager, see Hide an individual Hub and
Hide all unauthorized Hubs.

Syntax
>awusbmanager hidden hub list

Examples
Run the hidden hub list command.

>awusbmanager hidden hub list

A list of hidden Hubs is returned.

10.10.10.50:18574
10.10.10.21:18574
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hidden hub remove

Purpose
Remove a Hub from the hidden Hubs list.

Syntax
>awusbmanager hidden hub remove,<address>[:port]

The <address> is the address of the hub that you want to remove from the hidden Hub list. This is
required.
The <port> is the TCP port number for the Hub you want to remove. This is required if the TCP port
number is not the default (18574).

Examples
Run the hidden hub list command to verify the address and port number of the Hub that you
want to remove.

10.10.10.21:18574
10.10.10.34:18574
10.10.10.56:5600

Run the hidden hub remove command.
n If the TCP port number is the default, entering the port number in the command is optional.

>awusbmanager hidden hub remove,10.10.10.34

n If the TCP port number is not the default, entering the port number in the command is
required.

>awusbmanager hidden hub remove,10.10.10.56:5600

Run the hidden hub list command again to verify that the specified Hubs have been removed.

10.10.10.21:18574
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hidden hub remove all

Purpose
Remove all the Hubs in the hidden Hubs list.

Syntax
>awusbmanager hidden hub remove all

Examples
Run the hidden hub list command to view the list of hidden Hubs.

10.10.10.12:18574
10.10.10.14:18574
10.10.10.15:5600

Run the hidden hub remove all command.

>awusbmanager hidden hub remove all

Run the hidden hub list command again to verify that the Hubs have been removed.
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help

Purpose
Displays a list of the CLI commands for the AnywhereUSB Manager.

Syntax
>awusbmanager help
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hub info

Purpose
Displays information about the Hubs. For more information, see AnywhereUSB Manager Hub Status
pane.

Syntax
>awusbmanager hub info,<hub name>

The <hub name> is the address of the Hub for which you want to display information. The address is
required.

Examples
Run the list command to determine Hub's address.

AnywhereUSB Manager, below are the available devices:

AW02-000001 "HUB-000001" (AW02-000001.local.:18574)
Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service

Run the hub info command.

>awusbmanager hub info,AW02-000001

Information about the Hub displays.

NAME: AW02-000001
LOCALNAME: HUB-000001
MODEL: AnywhereUSB 2 Plus
VERSION: 3.0.0.54 awusb dby-3.0.0.54 01/03/2019 16:44:25 CST 20190103224522
STATE: Active (secure)
ADDRESS: AW02-000001.local. (SSL Subject:/C=US/ST=Minnesota/O=Digi International
Inc/CN=unknown ,Issuer:/C=US/ST=Minnesota/O=Digi International Inc/CN=unknown)
(10.10.74.xxx)
PORT: 18574
CONNECTED FOR: 22115 sec
CONNECTION ID: 1
INTERFACE: eth0
SERIAL NUMBER: AW02-000001
AUTOCONNECT: disabled
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hub name

Purpose
Change or assign the local name of the Hub.

Syntax
>awusbmanager hub name,<address[:port]>,<new name>

The <address> is the Hub's address.
The <port> is the TCP port number for the Hub you want to rename. This is required if the TCP port
number is not the default (18574).
The <new name> is the new local name for the Hub.

Examples
Run the list command to determine the Hub's address.

AnywhereUSB Manager, below are the available devices:

AW02-000001 (AW02-000001.local.:18574)
Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service

Run the hub name command.

>awusbmanager hub name,AW02-000001,Hub 1

Run the list command again to verify the local name.

AnywhereUSB Manager, below are the available devices:

AW02-000001 "Hub 1" (AW02-000001.local.:18574)
Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service
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known hub add

Purpose
Add a Hub to the known Hubs list. The Hubs in this list can be on the same network as your computer,
or on a different network. If you add Hubs to the known Hubs list that are on the same network as our
computer AND the autofind feature is enabled, duplicate entries display in the Hubs list.

Note For information about using this feature in the AnywhereUSB Manager, see Manage the list of
known Hubs.

Syntax
>awusbmanager known hub add,<address>[:port]

The <address> is the address of the Hub or a Hub hostname that can be resolved by your network
nameservers. This is required.
The <port> is the TCP port number, which is 18574 by default. You can change the TCP port number if
needed.

Examples

Add a known Hub
Run the known hub add command to add a Hub to the known Hub list.

n Use and address and the default port of 18574:

>awusbmanager known hub add,10.10.56.12

n Use a hostname and change the TCP port number:

>awusbmanager known hub add,awusb1.work.com:9999

n Change the TCP port number:

>awusbmanager known hub add,10.10.56.14:5600

You can then run the known hub list command to verify that the Hub was added to the list.

10.10.10.56:18574
awusb1.work.com:9999
10.10.56.14:5600
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known hub list

Purpose
Displays a list of Hubs that have been added to the known Hubs list.

Note For more information about known Hubs, see Manage the list of known Hubs.

Syntax
>awusbmanager known hub list

Examples
Run the known hub list command.

>awusbmanager known hub list

A list of known Hubs is returned.

10.10.10.50:18574
10.10.10.12:18574
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known hub remove

Purpose
Remove a Hub from the known Hubs list.

Note For information about using this feature in the AnywhereUSB Manager, see Manage the list of
known Hubs.

Syntax
>awusbmanager known hub remove,<address>[:port]

The <address> is the address of the hub that you want to remove from the known Hub list. This is
required.
The <port> is the TCP port number for the Hub you want to remove. This is required if the TCP port
number is not the default (18574).

Examples
Run the known hub list command to verify the address and port number of the Hub that you
want to remove.

10.10.01.12:18574
10.10.01.14:18574
10.10.01.15:5600

Run the known hub remove command.
n If the TCP port number is the default, entering the port number in the command is optional.

>awusbmanager known hub remove,10.10.01.14

n If the TCP port number is not the default, entering the port number in the command is
required.

>awusbmanager known hub remove,10.10.01.15:5600

Run the known hub list command again to verify that the Hubs have been removed.

10.10.01.12:18574
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known hub remove all

Purpose
Remove all the Hubs in the known Hubs list.

Syntax
>awusbmanager known hub remove all

Examples
Run the known hub list command to view the list of known Hubs.

10.10.01.12:18574
10.10.01.14:18574
10.10.01.15:5600

Run the known hub remove all command.

>awusbmanager known hub remove all

Run the known hub list command again to verify that the Hubs have been removed.
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list

Purpose
Displays a list of Hubs, groups, and devices on the network as well as any Hubs the
AnywhereUSB Manager knows about.

Note This information is similar to what displays in the AnywhereUSB Manager. See AnywhereUSB
Manager window.

If a group has auto connect enabled, an asterisk displays next to the group name.
Additional information about features displays at the bottom of the list:

n Status of the auto-find feature: enabled or disabled.

n Status of the auto connect all feature: enabled or disabled.

n Specifies whether the AnywhereUSB Manager is running as a service.

Syntax
>awusbmanager list

Examples
This example shows one Hub: AW02-000001. On the Hub, Group 1 has the auto connect feature
enabled, as specified by the asterisk next to the group name.

AnywhereUSB Manager, below are the available devices:

AW02-000001 "Hub 1" (AW02-000001.local.:18574)
Group 2 (AW02-000001.2) (In-use by you)
Group 1 (AW02-000001.1) (In-use by you)

U3 Cruzer Micro (AW02-000001.1101)

* means Autoconnect enabled, + means Autoconnect inherited
Auto-Find: enabled
Autoconnect All: disabled
AnywhereUSB Manager not running as a service
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list full

Purpose
Displays a list of all Hubs, groups, and devices on the network and includes all information about each
Hub, group, or device. This command displays the same information retrieved by running these
commands: list, hub info, group info, and device info.
If a group has auto connect enabled, an asterisk displays next to the group name.
Additional information about features displays at the bottom of the list:

n Status of the auto-find feature: enabled or disabled.

n Status of the auto connect all feature: enabled or disabled.

n Specifies whether the AnywhereUSB Manager is running as a service.

Syntax
>awusbmanager list full

Examples
Run the list full command.

>awusbmanager list full

The example below shows the Hub on the network, and the groups and devices on that Hub.
Information about the Hub, group, and device is also returned.

AnywhereUSB Manager, below are the available devices:

AW08-D00001 (10.10.12.12:18574)
NAME: AW08-D00001
MODEL: AnywhereUSB 8 Plus
VERSION: 3.0.1.2 awusb
STATE: Active (secure)
ADDRESS: 10.10.12.12
PORT: 18574
CONNECTED FOR: 14 sec
CONNECTION ID: 3
INTERFACE: eth0
SERIAL NUMBER: AW08-D00001
AUTOCONNECT: disabled

Group 2 (AW08-D00001.2)
ADDRESS: AW08-D00001.2
GROUP: 2
NAME: Group 2
PORTS: 5 6 7 8
AUTOCONNECT: disabled
IN USE BY: NO ONE

Cruzer (AW08-D00001.1906)
ADDRESS: AW08-D00001.1906
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VENDOR: SanDisk
VENDOR ID: 0x0781
PRODUCT: Cruzer
PRODUCT ID: 0x5530
SERIAL: 20040000920A1C707B00
AUTOCONNECT: disabled
IN USE BY: NO ONE

* Group 1 (AW08-D00001.1) (In-use by you)
ADDRESS: AW08-D00001.1
GROUP: 1
NAME: Group 1
PORTS: 1 2 3 4
AUTOCONNECT: enabled
IN USE BY: YOU

+ USB DISK 3.0 (AW08-D00001.1803) (In-use by you)
ADDRESS: AW08-D00010.1803
VENDOR:
VENDOR ID: 0x13fe
PRODUCT: USB DISK 3.0
PRODUCT ID: 0x6300
SERIAL: 070A00376967E000
AUTOCONNECT: inherited
IN USE BY: YOU

* means Autoconnect enabled, + means Autoconnect inherited
Autofind: disabled
Autoconnect All: disabled
AnywhereUSB Manager is running as a service
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You can configure the AnywhereUSB Hub from the command line interface (CLI). Configuring a Hub
through the CLI consists of entering a series of commands to set values in the device.

Access the command line interface 114
? 116
backup 117
display cloud 118
display device 119
display route 120
display tcp 121
display udp 122
display versions 123
exit 124
factory-default 125
findme 126
fwupdate 127
help 128
info ethernet 129
info icmp 130
info ip 131
info tcp 132
info udp 133
newpass 134
quit 135
reboot 136
revert 137
set cloud 139
set ethernet 140
set host 141
set network 142
set service 144
set system 146
set time 147
set usbclient 149
set usbgroup 151
show 152
who 153
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Access the command line interface
To configure devices using the command line interface:

1. Do one of the following to connect the AnywhereUSB to a computer.
n Using a serial port on the AnywhereUSB 8 Plus or Anywhere USB 24 Plus only: Connect

an RS-232 null modem cable between the Console port of the Hub and a PC or laptop
serial port, allowing CLI access directly through a Terminal emulation program. If your
computer doesn't have a serial port, you can use a USB serial adapter. Use the following
serial settings:
l Baud rate or Bits per second: 115200

l Data: 8 bit

l Parity: None

l Stop: 1 bit

l Flow control: none

n Using SSH for all AnywhereUSB® Plus models:

Open a terminal emulation program that supports SSH and connect to the IP
address assigned to the Hub.

2. The login prompt appears. Enter the user ID and password.
n user ID: admin

n password: The default password is found on the label of your Hub.

Note If you are unable to log in to your Hub, see Use the Reset button to restore factory
defaults for instructions on restoring the default password.

3. After you have successfully accessed the command line, the #> prompt is displayed.

Abbreviating Commands
You can abbreviate all commands by typing enough letters to uniquely identify the command.
Most terminal emulators use the following keyboard commands:

n Up arrow (or Ctrl-P)/Down arrow (or Ctrl-N) redisplays a few most recent commands. You can
execute one again with the Enter key.

n Backspace/Ctrl-H key deletes characters to the left of the cursor.

n Ctrl-B moves the cursor one character to the left within the line. Characters are inserted to the
left of the cursor when typed.

n Ctrl-F moves the cursor one character to the right within the line. Characters are inserted to
the left of the cursor when typed.

n The entire line is evaluated when Enter (Ctrl-M or Ctrl-J) is pressed, to the left and right of the
cursor.

n Ctrl-C cancels the line and gives a new prompt.

n Ctrl-D closes the CLI session.
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Syntax Conventions
Presentation of command syntax in this manual follows these conventions:

n Brackets [ ] surround optional material.

n Braces { } surround entries that require you to chose one of several options, which are
separated by the vertical bar, |.

n Non-italicized text indicates literal values, that is, options or values that must be typed exactly
as they appear. Yes and no options are examples of literals.

n Italicized text indicates that a type of information is required in that option. For example,
filename means that the name of a file is required in the option.
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?

Purpose
Displays options for the current line or command.

Syntax
#> ?

Options
None.

Examples

Display root commands

#> ?
backup display factory-default findme
fwupdate exit help info
newpass quit reboot revert
set show who ?

Display options for the set command

#> set ?
syntax: set [options...]
cloud host network service system time usbclient
usbgroup

Display options for the net command

#> set net ?
syntax: set network [options...]
options:
globalsettings
ip=(ipaddr)
submask=(subnet mask)
gateway=(gateway ipaddr)
dhcp=(on|off)
dns1=(primary dns server ipaddr)
dns2=(secondary dns server ipaddr)
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backup

Purpose
Save any configuration changes you have made to a file, and then restore a configuration by applying
the saved changes to any Hub.
This can also be done from the web UI. See Backup and restore settings for more detailed
information.

Syntax
backup [to=serveripaddress[:filename]]|
[from=serveripaddress[:filename]]|
[print]

Options

to=serveripaddress[:filename]
Stores the configuration file to the specified TFTP server and filename. A local file for [filename] may
be selected by specifying "local" as the [serveripaddress] value. If a filename is not specified, the
command uses the default filename of backup.cfg.

from=serveripaddress[:filename]
Restores the configuration file from the specified TFTP server and filename. A local file for [filename]
may be selected by specifying "local" as the [serveripaddress] value. If a filename is not specified, the
command assumes the default filename of backup.cfg.

from=term
Restores the configuration file from the terminal application. Press Ctrl-D at the end of input.

print
Prints out the current device configuration.

Example
#> backup from=10.0.0.1:config.cfg



Configure the AnywhereUSB Plus Hub from the CLI display cloud

AnywhereUSB® Plus User Guide for versions 3.x and below 118

display cloud

Purpose
Displays the status of the connection to Remote Manager.

Syntax
display cloud

Examples
#> display cloud
Device Type : AnywhereUSB 2 Plus
Device ID : 00000000-00000000-00409DFF-FF3C5C05
Status : Connected to 52.73.177.207:3199 from 10.10.12.14:48288
Server : remotemanager.digi.com
Connection Type : Device-initiated
Connection Method : TCP/SSL
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display device

Purpose
Displays general product information.
This information can also be displayed in the web UI. For more information, see Configuration and
Management web user interface.

Syntax
display device
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display route

Purpose
Displays Route Table entries.

Syntax
display route

Examples
#> display route
Kernel IP routing table
Destination Gateway Genmask Flags Metric Ref Use Iface
0.0.0.0 10.10.12.1 0.0.0.0 UG 10 0 0 eth0
10.10.12.0 0.0.0.0 255.255.255.0 U 0 0 0 eth0
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display tcp

Purpose
Displays active TCP sessions and active TCP listeners. display tcp provides current TCP information.

Syntax
display tcp

Examples
#> display tcp
Active Internet connections (only servers)
Proto Recv-Q Send-Q Local Address Foreign Address State
tcp 0 0 0.0.0.0:18574 0.0.0.0:* LISTEN
tcp 0 0 0.0.0.0:80 0.0.0.0:* LISTEN
tcp 0 0 0.0.0.0:22 0.0.0.0:* LISTEN
tcp 0 0 0.0.0.0:443 0.0.0.0:* LISTEN
tcp6 0 0 :::22 :::* LISTEN
Active Internet connections (w/o servers)
Proto Recv-Q Send-Q Local Address Foreign Address State
tcp 0 0 10.10.12.14:48288 52.73.177.207:3199 ESTABLISHED
tcp 0 0 10.10.12.14:18574 10.10.12.12:36634 ESTABLISHED
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display udp

Purpose
Displays current UDP listeners. display udp provides current UDP information.

Syntax
display udp

Examples
#> disp udp
Active Internet connections (only servers)
Proto Recv-Q Send-Q Local Address Foreign Address State
udp 0 0 0.0.0.0:5353 0.0.0.0:*
udp 0 0 127.0.0.1:323 0.0.0.0:*
udp 0 0 0.0.0.0:43850 0.0.0.0:*
udp6 0 0 ::1:323 :::*
Active Internet connections (w/o servers)
Proto Recv-Q Send-Q Local Address Foreign Address State
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display versions

Purpose
Displays EOS firmware version information.

Syntax
display versions



Configure the AnywhereUSB Plus Hub from the CLI exit

AnywhereUSB® Plus User Guide for versions 3.x and below 124

exit

Purpose
Logs you out of the Hub.

Syntax
exit
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factory-default

Purpose
Restore the AnywhereUSB® Plus Hub to the factory default configuration. The restore process clears
all current settings (including all previously stored client IDs and certificates), deletes all Hub and
AnywhereUSB Manager keys, resets the password for the administrative user, and restores the
settings to the factory defaults. After the Hub reboots, you must re-deploy the Hub.

Note You can also restore the Hub to the factory default settings from the web UI and the Reset
button on the Hub. The Reset button has the same action as the factory-default command. However,
if you restore the Hub to the factory defaults from the web UI, you have the option to retain the IP
address configuration option.

Syntax
factory-default
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findme

Purpose
Turns on/off an LED to aid in finding a specific Hub among a group of Hubs.

n AnywhereUSB 2 Plus: When enabled, the power LED blinks green, then orange.

n AnywereUSB 8 Plus and AnywhereUSB 24 Plus: When enabled, the user LED blinks green,
then orange.

Note You can also configure this feature on the Find Me page in the web UI.

Syntax
findme [option]

Options
enable={on|off}
Causes the Locator LED to blink or stop blinking.

on

Causes the Locator LED to blink.

off

Causes the Locator LED to stop blinking.

Examples

Display the current state of the Locator LED

#> findme

Cause the Locator LED to blink

#> findme enable=on
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fwupdate

Purpose
Updates the firmware on the Hub. The Hub reboots when the firmware update is complete.

Syntax
fwupdate [host]:[filename]

A local file for [filename] may be selected by specifying "local" as the [host] value.
The [host] is the literal "local" or a hostname or IP Address of the TFTP host that can serve this file.

Example
Load new firmware from local file update.bin.

#> fwupdate local:update.bin

Load new firmware from locale file AW08_firmware_A.bin

#> fwupdate 1.2.3.4:AW08_firmware_A.bin
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help

Purpose
Displays the commands that are available and the options available for a specific command.

Syntax
help

help [command]

Example
#> help
backup display factory-default findme
fwupdate exit help info
newpass quit reboot revert
set show who ?

#> help set

syntax: set [options...]

cloud host network service system time
usbclient usbgroup

#> help set net

syntax: set network [options...]

options:

globalsettings
ip=(ipaddr)
submask=(subnet mask)
gateway=(gateway ipaddr)
dhcp=(on|off)
dns1=(primary dns server ipaddr)
dns2=(secondary dns server ipaddr)
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info ethernet

Purpose
Displays Ethernet communications-related statistics.
Statistics that display are gathered since the statistic tables were last cleared by rebooting the Hub,
and include data, event, and error counts. These statistics are useful in understanding how the Hub is
operating and can be helpful in finding problems. In particular, if an error counter is found to be
increasing there may be a problem with the Hub.
To reset the statistics, reboot the device.

Syntax
info ethernet

Examples
#> info eth
Ethernet Statistics:
Bytes Received : 49094876 Bytes Sent : 177210984
Unicast Packets Received : 325217 Unicast Packets Sent : 155961
Receive Errors : 0 Send Errors : 0
Received Packets Dropped : 0 Sent Packets Dropped : 0
Multicast Packets Received : 0
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info icmp

Purpose
Displays statistics related to Internet Control Message Protocol (ICMP) activity.
Statistics that display are gathered since the statistic tables were last cleared by rebooting the Hub,
and include data, event, and error counts. These statistics are useful in understanding how the Hub is
operating and can be helpful in finding problems. In particular, if an error counter is found to be
increasing there may be a problem with the Hub.
To reset the statistics, reboot the device.

Syntax
info icmp

Example
#> info icmp
ICMP Statistics:
Datagrams Received : 0 Datagrams Sent : 0
Receive Errors : 0 Send Errors : 0
Unreachable Received : 0 Unreachable Sent : 0
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info ip

Purpose
Displays statistics relating to Internet Protocol (IP) activity.
To reset the statistics, reboot the device.

Syntax
info ip

Example
#> info ip
IP Statistics:
Datagrams Received : 201797 Datagrams Sent : 54487
Header Errors Received : 0 Datagrams Forwarded : 0
Address Errors Received : 10 Send No Route : 0
Unknown Protos Received : 0 Send Discarded : 0
Received Discarded : 0 Fragments Created : 0
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info tcp

Purpose
Displays statistics relating to Transmission Control Protocol (TCP) activity. Statistics displayed are
those gathered since the statistic tables were last cleared by rebooting the Hub, and include data,
event, and error counts. These statistics are useful in understanding how the Hub is operating and can
be helpful in finding problems. In particular, if an error counter is increasing there may be a problem
with the Hub.
To reset the statistics, reboot the device.

Syntax
info tcp

Example
#> info tcp
TCP Statistics:
Segments Received : 94106 Segments Sent : 147569
Currently Established : 2 Segments Retransmitted : 213
Passive Opens : 2907 Active Opens : 1
Receive Errors : 0 Attempt Fails : 0
Established Resets : 4 Resets Sent : 1
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info udp

Purpose
Displays statistics for User Datagram Protocol (UDP) communications activity.
To reset the statistics, reboot the device.

Syntax
info udp

Example
#> info udp
UDP Statistics:
Datagrams Received : 13877 Datagrams Sent : 2665
Receive Errors : 0 No Ports : 0
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newpass

Purpose
Creates or changes administrator password for the Hub.
You can also change the password in the web UI. See Change the Hub password.

Syntax
newpass

You are asked for the current password, the new password, and then to repeat new password.

Examples
#> newpass
changing password for user admin
current password:
new password:
repeat new password:
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quit

Purpose
Logs you out of the Hub.

Syntax
quit

Example
#> quit
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reboot

Purpose
Reboots the Hub.

Note You can also reboot the Hub from the web UI. See Reboot the Hub.

Syntax
reboot

Wait approximately 15 seconds for the reboot to complete. When the reboot is complete, all the LEDs
turn on and then turn off, leaving the power LEDs on. For the AnywhereUSB 24 Plus model, one or both
of the power LEDs will be on.
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revert

Purpose
Sets a particular group of a Hubs settings to its default values. Only one settings-group keyword can
be specified per revert command. That is, entering several keywords on a single command to revert
multiple settings is not allowed. A revert all command reverts all device settings but network,
security, and host key/certificate settings.

Syntax
revert [option]

Options
cloud
Reverts the Remote Manager settings to the default settings.
host
Reverts the host name set by the set host command.
network [all|globalsettings|interface=comma separated list of interface names]
Reverts these network settings (see set network):

n Ethernet settings, configured by the set ethernet command.

n Network settings, configured by the set network command.

revert network all

Reverts settings for all interfaces to default settings.

revert network globalsettings

Reverts the global network settings. See set network for details on these options.

revert network interface=[comma-separated list of interface names]

Reverts the interface-specific network settings for the specified interfaces. The
interface option can be abbreviated as if.

revert network

revert network with no options is equivalent to revert network all.

service
Reverts the service settings to the default settings.
system
Reverts the system settings to the default settings.
time
Reverts the time settings to the default settings.
usbclient
Reverts the client list to default client list.
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usbgroup
Reverts to the groups to the default group list.
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set cloud

Purpose
Enables you to enable and configure the Hub's access to Remote Manager.

Note This command performs the same functions as the options in the Remote Manager
Configuration page in the web UI.

Syntax
set cloud [options]

Options
server=[server address text]
Enter the name of your Remote Manager server.
enable=[on|off]
Enables or disables Remote Manager.
reconnect=[none|(10-3600 seconds)]
Specify the amount of time to wait after the Hub has been disconnected from Remote Manager
before the Hub should automatically try to reconnect. The time is measured in seconds.
rxkeepalive=[5-7200 seconds]
Specify the interval at which the Hub sends a keep-alive packet to Remote Manager if the Remote
Manager connection is idle. Remote Manager expects to receive either Remote Manager protocol
messages or keep-alive packets at the specified interval. The time is measured in seconds.
txkeepalive=[5-7200 seconds]
Specify the interval at which the Remote Manager-registered Hub sends a keep-alive packet to
Remote Manager if the Remote Manager connection is idle. The Hub expects to receive either Remote
Manager protocol messages or keep-alive packets at the specified interval. The time is measured in
seconds.
waitcount=[2-64]
Specify the number of consecutive keep-alives can be missed before the connection between Remote
Manager and the Hub is considered lost and subsequently closed by the Hub and Remote manager.
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set ethernet
Note This command applies to the AnywhereUSB 24 Plus only.

Purpose
Configures the bonding mode for the Ethernet network. The Hub has two physical Ethernet network
ports that use the same MAC address and share one IP address. When both ports are being used, they
act as one Ethernet network port.
You can also configure bonding in the web UI. See Ethernet network bonding.

Syntax
set ethernet [option]

Option
bonding=[active-backup|balance-rr]

active-backup

The Hub uses only one of the Ethernet network connections at a time. If one Ethernet
network connection fails, all data is sent from the second Ethernet network connection.

balance-rr

The Ethernet network connection alternates between the two ports as the Hub sends
data. If one Ethernet network connection fails, all data is sent from the second Ethernet
network connection.

Examples
Configure fault tolerance (active backup)

#> set ethernet bonding=active-backup

Configure load balancing (round robin)

#> set ethernet bonding=balance-rr
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set host

Purpose
Configures a name for the Hub, also known as a host name, or displays the current host name for the
Hub.

Note The name can consist of the following characters: 0-9, A-Z, a-z, dash (-), or period (.). You cannot
use spaces, underscores (_), comma (,), forward slash (/), back slash (\), or ampersand (&).

Syntax

Configure a host name for the device

set host name=name

Display the current host name

set host

Options
name=name
The name for the Hub. If provided, this host name is placed in the DHCP Option 12 field when the
device is configured as a DHCP client (by set network) and requests IP configuration from a DHCP
server. This is an optional setting that is only used when DHCP is enabled.
The name can be up to 32 characters long and can contain any alphanumeric characters, and can also
include the _ (underscore) and - (hyphen) characters.

Examples

Set a host name

#> set host name=hqgateway

Remove an added host name

#> revert host

or

#> set host name=""
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set network

Purpose
Sets and displays network interface settings.

Syntax

Set network configuration options

set network [options]

Display current network configuration options

set network

Options

interface specific options
Set configuration options for network interfaces for the Digi device.
globalsettings
Global network settings include setting a gateway priority; that is, the default gateway is used to
route IP packets to an outside network, unless controlled by another route, and the device’s use of
Domain Name Server (DNS).
ip=[ipaddr]
Sets the device IP address when DHCP is off.
submask=[subnet mask]
Sets the device subnet mask address when DHCP is off.
gateway=[gateway ip address]
Sets the network gateway IP address.
The following three IP address options have a precedence. That is, if all three options are turned on,
the order of precedence is: static, dhcp, autoip.
dhcp=[on|off]
When enabled, the device attempts to use the DHCP protocol to find an IP address, gateway address,
and submask. The default is on
dns1=[primary dns server ipaddr]
The name of the primary DNS server.
dns2=[secondary dns server ipaddr]
The name of the secondary DNS server.
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Examples

Manually set the device IP address

#> set network ip=10.0.0.1 gateway=255.255.255.0 submask=255.255.255.0
dhcp=off

Enable DHCP

#> set network dhcp=on
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set service

Purpose
Used to:

n Enable and disable network services.

n Change the network port on which a given service listens.

n Display the entire service table, or an entry in the service table.

Syntax

Enable/disable network services or change network port for service

set service [range=range]
[state={on|off}]
[ipport=network_port]

Display service table or entries in the table

set service [range=range]

Options
range=range
Used to specify the index of the network service to which the rest of the command’s options apply.
This range varies among Digi devices. Enter set service to display the index numbers for the network
services on your Digi device.
state={on|off}
Used to enable or disable a given network service.
ipport=network port
Used to change the network port on which a given network service listens.

Supported network services
The following table shows the network services controlled by the set services command and the
services provided.
The following types of network services are available:

Service Services Provided

HTTP Hypertext Transfer Protocol, also known as Web Server. Provides
access to web pages for configuration that are secured by
requiring a user login. A user login is required for AnywhereUSB
Plus Hubs.
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Service Services Provided

HTTPS Hypertext Transfer Protocol over Secure Socket Layer), also
known as Secure Web Server. Provides access to web pages for
configuration that can be secured by requiring a user login, with
encryption for greater security.

SSH Secure Shell service. Allows users secure access to log in to the
Digi device and access the command-line interface.

AnywhereUSB

MDNS The MDNS port is not configurable.

Examples

Disable HTTP

#> set service range=4 state=off

Change the network port (ipport) of a service

#> set service range=4 ipport=500

Displaying the service table
In this example, the set service command displays the entire service table.

#> set service

Displaying an entry in the service table
In this example, the set service command displays a range of entries in the service table.

#> set service range=2-4
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set system

Purpose
Configures and displays system-identifying information, such as a description of the device, its
location, and a contact person.

Syntax

Change system-identifying information

set system [description=string]
[location=string]
[contact=string]

Display system-identifying information

set system

Options
description=string
A description of this device. The maximum length is 64 characters. The default is "" (blank description
field).
location=string
The location of this device. The maximum length is 64 characters. The default is ""(blank location
field).
contact=string
The contact for this device. The maximum length is 64 characters. The default is ""(blank contact
field).

Examples

Set description, contact, and location

#> set system description="Engineering printer" location="Room 1347"
contact="John Doe at x-3749"
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set time

Purpose
Sets the Coordinated Universal Time (UTC) and/or system time and date on a Digi device.
All Digi devices maintain time and date as the UNIX epoch (00:00:00, January 1, 1970) plus device up-
time. On devices with no real-time clock (RTC), date and time revert to the UNIX epoch on each reboot
or power-cycle. On devices with a RTC, date and time is the UNIX epoch plus time since initial power-
up.
On a Digi device with no real-time clock and no configured clock source, time and date are completely
local to the device and have limited usefulness since they are not persistent over reboots/power-
cycles.
On a device with a RTC and no configured clock source, time and date are also local to the device, but
they are meaningful because they are persistent.
On a device with a configured clock source, time and date received from a clock source are expected
to be UTC.

Syntax
set time [options]

Options
time=hh:mm:ss|hh:mm
The time. Hours can range from 00 to 23, minutes can range from 00 to 59, and seconds can range
from 00 to 59. If omitted, all default to 00.
date=mm.dd.yy
The date. Month can range from 01 to 12, day can range from 01 to 28, 29, 30, or 31, depending on the
month and leap year, and year can range from 00 to 36, representing the years 2000 through 2036.
timezone=string
Enter the time zone name, such as CST6CDT or Chicago.
ntp_enable=on|off
Enable or disable time server synchronization.
serverN=ntp server name
The name of the NTP server, where N is the server number.
N=server index [1-4]
Specify the number of the NTP server.

Example

Set NTP server #1 to 0.time.digi.com

#> set time server1=0.time.digi.com
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Set the date and time to 2:15 PM, April 3, 2008

#> set time time=14:15 date=04.03.08
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set usbclient

Purpose
Add a client ID to the client list. When a computer searches for Hubs, any computer with a client ID on
the client list can connect to the Hub. You can also add client IDs in the web UI. See Manually add a
client ID.
Automatically register or reject computers that have not previously connected to the Hub. See
Automatically register unknown clients for more information.

Syntax
set usbclient [option]

Options

Use these options to add a client ID to the client list.
index=[1-24]
Specify the client index.
id=[string]
Specify the client ID for the computer.
description=[string]
Specify a descriptive name for the computer.
groups=[list]
Specify the groups this client ID can access.

Use these options to register or reject unknown clients.
autoreg=[on|off]
Determine whether unknown clients should be registered.
autoreg_groups=[list]
List the group numbers to which an unknown client is allowed access.

Examples

The client ID can access one group

set usbclient index=1 group=1

The client ID can access multiple groups
The AnywhereUSB Manager can connect to one or all of these groups at one time.

set usbclient index=3 groups=1,6-8
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Automatically register unknown clients

set usbclient index=3 autoreg=on
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set usbgroup

Purpose
Assign a name to each group and specify the ports in each group. When a client connects to a group in
the AnywhereUSB Manager, the user has access to all of the ports in the group.
You can change the name for a group in the Group Description field. By default, a group is named
"Group" appended by a consecutive number, such as Group 1, Group 2, and so on. This name displays
in the Group Name field in the Group Status pane.
For each group, you can specify ports. Each port can only be assigned to one group. Any unassigned
ports are selected in the Unassigned row that displays beneath the list of groups.
You can also do this in the web UI. See Create groups and assign ports to the group.

Syntax
set usbgroup [option]

Options
group=[1-24] ports = [list]
Specify group number to change and a single port or a range of ports to assign to this group.

Note Ports can only be assigned to one group at a time. If a port is assigned to a new group, it is
removed from the current group.

description=[string]
Enter a name for the group. You must have double quotes around the name if the name has spaces.

Examples

Specify a group name

set usbgroup group=1 description=usergroup1

set usbgroup group=1 description="user group 1"

Assign ports to a group
Assign ports 1, 2, 3, 4, and 7 to group 1.

set usbgroup group=1 ports=1-4,7

Assign port 8 to group 3.

set usbgroup group=3 ports=8
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show

Purpose
Displays the current settings in a Hub.

Syntax
show [options] [options]

Options
[options] [options]
Specifies which settings in the device to show, for example, show time. The following table shows the
options can be specified.

options

Lists any additional options, which depend on the settings group.

Throughout these descriptions, the following descriptions apply to the port and range
options:

port=range

Identifies a particular serial port. Optional on a single-port device.

range=range

A configuration table entry or range of entries.
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who

Purpose
Displays active connections to and from the Hub.

Syntax
who

Examples

Display a list of all current connections

#> who
ID Local address Remote address Service
-- --------------------- --------------------- --------------------
1 10.10.12.14:18574 10.10.12.19:57536 AnywhereUSB
2 10.10.12.14:18574 10.10.12.16:37298 AnywhereUSB
3 10.10.12.14:18574 10.10.12.11:50217 AnywhereUSB
4 10.10.12.14:18574 10.10.12.12:34844 AnywhereUSB
5 10.10.12.14:22 10.10.12.16:37301 Command line
6 10.10.12.14:60348 52.73.177.207:3199 Remote manager
7 10.10.12.14:18574 10.10.12.28:37324 AnywhereUSB



Deployment

This process describes how to re-deploy a Hub.

Note If you want to deploy a new Hub, see Get started.

1. If you are re-deploying a Hub, remove the Hub from the network.

2. Make a connection between the Hub and each computer that should be allowed to connect to
the Hub.

a. Connect the hardware.

b. Verify initial connection.
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Security

Security-related features in AnywhereUSB® Plus include:
n Unique password for each Hub. See Change the Hub password.

n Configurable network service port numbers.

n Secure access and authentication to the web UI and CLI.

n One password, one permission level.

n Selectively enable and disable network services such as mDNS, HTTP/HTTPS, and SSH.

n Encrypted access to AnywhereUSB® Plus traffic: Access to the USB-over-IP traffic is encrypted
and authenticated by default. This cannot be disabled.

Client ID
The client ID is a unique identifier assigned to a user account the first time a user logs in to a
computer and opens the AnywhereUSB Manager. During this process, the AnywhereUSB Manager
creates a secure identity certificate that is associated with the client ID. This certificate is used to
validate your user account with the Hub.
After a user has created a client ID for their user account, the computer is able to connect to the Hubs
that recognize that client ID.

Create a client ID during initial launch of the AnywhereUSB Manager
The AnywhereUSB Manager can be initially opened by a user in one of the following ways:

n Installation: When the AnywhereUSB® Plus Hub software is installed, the Launch
AnywhereUSB Manager option is selected by default. When the installation completes, the
client ID confirmation dialog appears. The user enters a client ID, and then the AnywhereUSB
Manager is automatically opened.

Note If the user deselects the Launch AnywhereUSB Manager option, the AnywhereUSB
Manager does not automatically open after the installation process completes. In this case,
the client ID dialog does not display.

n New user logs in: After the AnywhereUSB® Plus Hub software is installed, any user can log
into that computer and open the AnywhereUSB Manager. The first time a user opens the
AnywhereUSB Manager, the client ID dialog appears. The user must enter a client ID before
the AnywhereUSB Manager will open.
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After the initial launch of the AnywhereUSB Manager, the next time the user logs in, the computer is
able to connect to the Hubs that recognize that client ID.

Multiple user accounts with the same client ID
In some cases, multiple computers may inadvertently use the same client ID. When this occurs and
computers with the same client ID attempt to connect with the same Hub, the first computer to
associate itself with the Hub will be able to connect to the Hub. Subsequent computers will not be
able to connect that Hub.
If you discover that multiple computers are assigned the same client ID, see AnywhereUSB Manager
client ID is not unique for help solving this issue.



Troubleshooting

The following information provides troubleshooting steps for the most common issues. To find
information on other issues, visit our Knowledge Base at knowledge.digi.com.

AnywhereUSB Manager client ID is not unique 158
No remote Hubs found 158
Hide a group in the AnywhereUSB Manager 158
Invalid Hub certificate 159
Services turned off and locked out of the Hub 159
Microsoft Windows restrictions 160
Hubs and virtual machines 160
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AnywhereUSB Manager client ID is not unique
When you install the AnywhereUSB Manager, you must assign a client ID to your computer, which
must be unique.

Note See Client ID for more information about how the client ID is used by your computer and the Hub
to create a connection.

In some cases, multiple computers may inadvertently be used by the same client ID. When this occurs,
and computers with the same client ID attempt to connect with the same Hub, the first computer to
associate itself with the Hub will be able to connect to the Hub. Subsequent computers will not be
able to connect to that Hub.
You can fix this issue by changing the client ID of your computer to a unique client ID. See Change the
client ID.

No remote Hubs found
When the host computer is unable to discover any AnywhereUSB® Plus devices on the network, no
Hubs are displayed in the AnywhereUSB Manager.

Firewall software blocks the port used for Hub discovery
When firewall software blocks the port used for Hub discovery, try the following:

n For firewall software, either disable it or add an exception for the port (UDP port 5353).

n Check for a link light on the Ethernet port. If the link light is not lit, connect all of the Hubs to
switches using network cables.

n Verify that the Autofind Hubs option is selected in the Preferences dialog in the
AnywhereUSB Manager. Start the Manager and choose File > Preferences to open the dialog.

n Connect the Hub directly to the host computer.

n Some anti-virus software might block the connection. You can either temporarily disable it or
add an exception for the AnywhereUSB Manager executable.

n If the Hub is across a switch or router that does not forward Bonjour traffic, the
AnywhereUSB Manager will not be able to discover the Hub. In this case, add the Hub to the
known Hubs list. See Manage the list of known Hubs.

n The firewall or router may block access to the AnywhereUSB port, which by default is TCP port
18574. If the Hub can be discovered but the connection fails (the state of the connection is
"Unable to connect"), you may need to reopen the AnywhereUSB port.

Hide a group in the AnywhereUSB Manager
Any group that has ports assigned to it displays in the AnywhereUSB Manager, even if no USB devices
are connected to a port. If you don't want groups with unused ports to display in the AnywhereUSB
Manager, you can reassign all of the ports in a group to a different group. Once the group does not
have any ports assigned to it, that group will not display.



Troubleshooting Invalid Hub certificate

AnywhereUSB® Plus User Guide for versions 3.x and below 159

1. Open the web UI from your selected Hub.

2. Click AnywhereUSB from the Configuration section. The AnywhereUSB Configuration page
appears.

3. Locate the group that has the unused ports.

4. Reassign each port in the group to a different group, or to the Unassigned row.

5. When done, click Apply to save the changes.

6. Return to the AnywhereUSB Manager. The group no longer appears.

Invalid Hub certificate
In some situations, the Hub certificate may become invalid. If this occurs, you can remove the Hub
from the Manage Hub Credentials list. The AnywhereUSB Manager forgets the Hub certificate and, if
the Auto-register Hub Cert option is selected in the Preferences dialog, gets a new one on the next
connection attempt.
If the Auto-register Hub Cert option in the Preferences dialog is not selected, you can manually add
the Hub to the Manage Hub Credentials list. After it is added, the AnywhereUSB Manager gets a new
certificate for the Hub on the next connection attempt.

Note The Hubmust be on a secure network before you manually add the Hub to the Manage Hub
Credentials list or if you remove the certificate and a new one is automatically assigned over the
network.

Services turned off and locked out of the Hub
If you use the set service CLI command to turn off services, be aware that if you turn off all of the
services and the web UI, you will be locked out of the Hub and unable to access it.
If this happens, follow the process below to reconnect to the Hub.

1. Remove the Hub from the deployed network.

2. Press the Reset button on the Hub to restore the factory defaults.

3. Connect the hardware.

4. Verify initial connection.

5. Configure the Hub settings.

6. Reconnect the Hubs to the existing AnywhereUSB Managers.
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Microsoft Windows restrictions

Microsoft Remote Desktop
Some devices (such as a web camera), and some input devices (such as a USB keyboard or a mouse),
are blocked andmay not display when Microsoft Remote Desktop is connected to a laptop or a virtual
machine.
For example, laptop A is connected to an AnywhereUSB® Plus Hub on the network, and a web camera
is connected to a port on the Hub. Laptop A is able to see the video feed from the camera.
A user on laptop B can use Microsoft Remote Desktop to gain access to laptop A. In this situation, the
video feed for both laptop A and laptop B is restricted by Windows and neither user can view the video
feed from the web camera.

Hubs and virtual machines
Hubs may not function properly when attached to a Guest OS on a virtual machine.
To resolve this issue, ensure that the extensions for the virtual machine have been installed on the
Guest OS.



Hardware

The physical dimensions, environmental, and power requirements of the AnywhereUSB® Plus Hub can
be found in the AnywhereUSB Plus data sheet.

Use the Reset button to restore factory defaults
Note Using the reset button is the most extreme factory reset option.

If the AnywhereUSB® Plus Hub is physically accessible, you can use the Reset button on the Hub to
restore the configuration to factory defaults. The restore process clears all current settings (including
all previously stored client IDs and certificates), deletes all Hub and AnywhereUSB Manager keys,
resets the password for the administrative user, and restores the settings to the factory defaults.

Note You can also restore the Hub to the factory default settings from the web UI and the factory-
default CLI command. The Reset button has the same action as the factory-default command.
However, if you restore the Hub to the factory defaults from the web UI, you have the option to retain
the IP address configuration option.

After you restore the factory defaults on a Hub, none of the existing AnywhereUSB Managers will be
able to connect to the Hub. When the Hub is restored, the Hub creates a new Hub certificate, which
will not be accepted by the existing AnywhereUSB Managers. To ensure that the new Hub certificate
is accepted by the existing AnywhereUSB Managers, you must re-deploy the Hub.

1. Hold down the Reset button for about 10 seconds until all the USB LEDs blink twice.
n AnywhereUSB® Plus 2: Reset button is on the front panel.

n AnywhereUSB® Plus 8: Reset button is on the back panel.

n AnywhereUSB® Plus 24: Reset button is on the side panel.

2. Release the Reset button.

3. The Hub automatically reboots.

4. You must re-deploy the Hub.
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Regulatory and safety information

Safety warnings
Review the following safety warnings for AnywhereUSB® Plus Hub.

WARNING! Notice the following safety warnings:
n Risk of explosion if battery is replaced by incorrect battery type. Dispose of

used batteries according to the instructions.

n This equipment is not suitable for use in locations where children are likely
to be present.

n This is equipment is suitable for installation in Information Technology
Rooms in accordance with Article 645 of the National Electrical Code and
NFPA 75.

n Use certified and rated Laser Class I Optical Transceiver product.

n Ensure that the power cord is connected to a socket-outlet with earthing
connection.

n Never open the equipment. For safety reasons, the equipment should be
opened only by skilled person.

WARNING! Risk of electric shock.

WARNING! Disconnect all energy sources.
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AVERTISSEMENT! Notice the following safety warnings:
n Risque d'explosion si la batterie est remplacée par un type de pile incorrect.

Jeter les piles usées selon les instructions.

n Cet équipement ne convient pas pour une utilisation dans des endroits où
des enfants sont susceptibles d'être présents.

n Convient pour l'installation dans les salles informatiques conformément à
l'article 645 du code national de l'électricité et à la norme NFPA 75.

n Utilisez un produit émetteur-récepteur optique laser de classe I certifié et
évalué.

n Veillez à connecter le cordon d'alimentation à une prise de courant avec
mise à la terre.

n Ne jamais ouvrir l'équipement. Pour des raisons de sécurité, l’équipement
ne doit être ouvert que par du personnel qualifié.

AVERTISSEMENT! Attention! Danger de choc.

AVERTISSEMENT! Déconnecter toutes les source d'énergie.



Океан Электроники
Поставка электронных компонентов 

Компания «Океан Электроники» предлагает заключение долгосрочных отношений при 

поставках импортных электронных компонентов на взаимовыгодных условиях! 

Компания «Океан Электроники» является официальным дистрибьютором и эксклюзивным 
представителем в России одного из крупнейших производителей разъемов военного и 
аэрокосмического назначения «JONHON», а так же официальным дистрибьютором и 
эксклюзивным представителем в России производителя высокотехнологичных и надежных 
решений для передачи СВЧ сигналов «FORSTAR». 

Наши преимущества: 

- Поставка оригинальных импортных электронных компонентов напрямую с производств Америки, 
Европы и Азии, а так же с крупнейших складов мира; 
- Широкая линейка поставок активных и пассивных импортных электронных компонентов (более 
30 млн. наименований); 
- Поставка сложных, дефицитных, либо снятых с производства позиций; 
- Оперативные сроки поставки под заказ (от 5 рабочих дней); 
- Экспресс доставка в любую точку России; 
- Помощь Конструкторского Отдела и консультации квалифицированных инженеров; 
- Техническая поддержка проекта, помощь в подборе аналогов, поставка прототипов;  
- Поставка электронных компонентов под контролем ВП; 
- Система менеджмента качества сертифицирована по Международному стандарту ISO 9001; 
- При необходимости вся продукция военного и аэрокосмического назначения проходит 
испытания и сертификацию в лаборатории (по согласованию с заказчиком);
- Поставка специализированных компонентов военного и аэрокосмического уровня качества 
(Xilinx, Altera, Analog Devices, Intersil, Interpoint, Microsemi, Actel, Aeroflex, Peregrine, VPT, Syfer, 
Eurofarad, Texas Instruments, MS Kennedy, Miteq, Cobham, E2V, MA-COM, Hittite, Mini-Circuits, 
General Dynamics  и др.); 

«JONHON» (основан в 1970 г.)

Разъемы специального, военного и аэрокосмического 
назначения: 
(Применяются в военной, авиационной, аэрокосмической, 
морской, железнодорожной, горно- и нефтедобывающей 
отраслях промышленности) 

«FORSTAR» (основан в 1998 г.) 

ВЧ соединители, коаксиальные кабели, 
кабельные сборки и микроволновые компоненты: 

(Применяются в телекоммуникациях гражданского и 
специального назначения, в средствах связи, РЛС, а так же 
военной, авиационной и аэрокосмической отраслях 
промышленности). 

Телефон:    8 (812) 309-75-97 (многоканальный) 
Факс:           8 (812) 320-03-32 
Электронная почта:    ocean@oceanchips.ru 
Web:      http://oceanchips.ru/ 
Адрес:   198099, г. Санкт-Петербург, ул. Калинина, д. 2, корп. 4, лит. А


